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Preface

Welcome to the Oracle Customer Relationship Management, Release 11i, suite of 
applications.

This Concepts and Procedures provides information and instructions to help you 
work effectively with Oracle Email Center.

This preface explains how Concepts and Procedures is organized and introduces 
other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

■ Technical Service Representatives (TSR)

■ Customer Service Representatives (CSR)

■ Interaction Center Supervisors, Operations Managers, and System 
Administrators

This guide assumes you have the following prerequisites:

■ Understanding of the company business processes

■ Knowledge of products and services as defined by your marketing policies

■ Basic understanding of Oracle

Structure
This manual is a compilation of the eMail Center online help system.  The topics are 
organized into the following groups: 
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"Understanding eMail Center" provides overviews of the application and its 
components, explanations of key concepts, features, and functions, as well as the 
application’s relationships to other Oracle or third-party applications.

"Using eMail Center" provides process-oriented, task-based procedures for using 
the application to perform essential business tasks. 

Related Documents
For more information, see the following manuals:

■ Oracle eMail Center Installation and Configuration Guide
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Understanding Oracle eMail Center

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications.

This topic group covers the following topics:

Overview of eMail Center

How Does eMail Center Work?

Overview of eMail Center Modules

eMail Center Client

Bulk Outbound Tech Stack

eMail Center Templates

eMail Center Flexibility

Concepts and Terminology

eMail Center Architecture and Tech Stack

Web Server HTML Form Processing

Overview of System Process Flows

Inbound Process Flow

Unstructured Email Processing

Routing, Queuing, and Delivery

Web Form Processing

Structured Email Processing
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Desktop Interaction Delivery

Automated Outbound Processing

Usage Scenarios

Inbound Scenarios

Outbound Scenarios

Processing Overview

Inbound Processing

Outbound Processing

Overview of eMail Center
Oracle eMail Center is a complete solution for managing email based interactions 
with customers, partners, suppliers, employees, or other entities that interact with 
or within an organization.

eMail Center is a powerful enabler for rapidly implementing flexible self-service 
and process automation oriented eBusiness solutions, using email as a 
communication channel.

How Does eMail Center Work?
Incoming email can be broadly categorize into structured and unstructured types. 
Structured emails are created by filling out a form or a template, it can be any text 
template or an HTML form on the WWW. Unstructured emails are typical, free 
form text messages.

Oracle eMail Center invokes appropriate, customizable processes that are targeted 
to handle different types of inbound email interactions. Workflow processes are 
setup to automatically resolve inbound structured email. Unstructured inbound 
email is passed through Oracle interMedia Text processing to determine the intent 
of the message. Workflow processes are then setup to attempt automatic resolution 
of these interactions based on the message intent/classification. Inbound 
interactions that cannot be automatically resolved are routed to the appropriate 
human agent in the Interaction Center using both rule and skill based routing 
schemes.

Once an email message gets to an agent, the eMail Center provides tools and 
capabilities to maximize agent productivity and effectiveness by providing 
fully-formed suggested responses for inbound emails and a high-performance 
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point-and-click agent interface that minimizes the need for typing, includes a 
spellchecker, and the ability to attach or insert appropriate documents. Oracle eMail 
Center allows storage and retrieval of documents, URLs and images from 
Marketing Encyclopedia System (MES). eMail Center also allows interMedia text 
queries on both the Marketing Encyclopedia System (MES) and the Solution 
Management System (SMS) knowledge bases.

In addition to managing inbound email interactions, eMail Center provides 
capabilities to initiate and manage outbound interactions. System generated or 
external application generated notifications can be automatically sent as emails, 
whose format adheres to all the business practices configured into the system.

Email-based sales, marketing, and advertising campaigns can also be executed. 
Oracle eMail Center can process campaign lists, expand the campaign content 
material, add tracking tags, and send personalized emails to addresses in the list. 
eMail Center can also track responses to these emails and tie them into campaign 
effectiveness analyses.

Overview of eMail Center Modules
eMail Center provides system administration, operations configuration, and 
supervisor modules. The system administration module provides a graphical user 
interface for defining, viewing, monitoring, and controlling system behavior.

Operations configuration screens allow authorized Contact Center domain experts 
(Operations Managers) to configure operational rules or business practices for eMail 
Center, and to specify business process attributes.

The supervisor interface allows Contact Center supervisors or managers to monitor 
and adjust the real-time operations of the Contact Center (eMail Center) and 
perform reporting and business analysis functions.

With these capabilities, Oracle eMail Center extends the paradigm for email 
response management systems (ERMS). Going beyond basic email response 
management, it enables complete email interaction management and email based 
process automation, to deliver a sophisticated email interaction management 
solution.

eMail Center Client
The following diagram depicts the architecture of the client portion of eMail Center:
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Bulk Outbound Tech Stack
The following diagram depicts the system flow and tech stack for bulk outbound:
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eMail Center Templates
Oracle eMail Center utilizes three different types of templates, including: HTML 
form templates, response templates, and process automation workflows.

HTML form templates are web forms that are filled in by the end-customer to 
submit structured requests. You can use the Structured Email Template Creation 
Cookbook and any HTML authoring tool to add eIM specific tags. eMail Center 
provides several sample templates, including: collateral request, service request, 
create order, event registration, schedule callback.

Response templates are complete responses that contain merge fields for 
pre-defined auto-responses. You can use any HTML or plain text authoring tool to 
create or customize these templates. eMail Center provides several sample 
templates, including: responses to collateral request, and service request.

Process automation workflows are workflow templates used to automate the 
process of resolving structured email requests. You use Oracle Workflow to build 
these workflow templates. eMail Center provides several sample workflows, 
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including: collateral request, service request, create order, event registration, and 
schedule callback.

eMail Center Flexibility
eMail Center extensively leverages Oracle products and technologies to deliver a 
highly reliable, scalable, flexible, and advanced solution. It is designed to integrate 
easily with Oracle CRM and ERM applications to email enable these applications 
and facilitate the implementation of end-to-end solutions.

Additionally, eMail Center pre-integration with Oracle Call Center product 
modules provides comprehensive service level guaranty, unified interaction channel 
management, and interaction center productivity & effectiveness maximizing 
capabilities.

While eMail Center will generate the most value for enterprises when integrated 
with Oracle CRM and ERM applications, its flexible design allows its use with third 
party systems with relatively little implementation effort. Oracle may also provide 
integration bridges for selected third party systems in the future.

Concepts and Terminology
The following list of concepts and terminology will help minimize 
miscommunication of information within the documentation.

Advanced Queueing: Advanced Queuing is a feature of the Oracle 8i database that 
will provide asynchronous, loosely-coupled communication between the eMail 
Center rules engine and the eMail Center server.

The eMail Center PLSQL rules engine will use AQ to inform the eMail Center 
server that a new email has arrived.

Agent: Also called a CSR (customer service representative). eMail Center agents 
respond to and resolve incoming interactions. Agents may also create outbound 
interactions.

Agent productivity tool: Product feature designed to increase the productivity and 
effectiveness of agents.

Attachment: A computer file sent along with an email message.

Attachment type: The file format for the attachment. Examples: Word document, 
Excel spreadsheet, Powerpoint presentation, etc.
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Automated acknowledgement: A pre-composed (canned) email message sent back 
to the sender of an incoming message to acknowledge that the message was 
received. Additional static information (such as time frame within which a response 
can be expected from the interaction center) may also be included in the automated 
acknowledgement.

Automated response: A system generated response addressing the intent of the 
incoming message. Automated responses involve no human intervention.

Case: Term used to track and group all interactions and associated information 
related to a particular issue or related set of issues. 

Classification: A label that identifies the intent of a message. A classification can be 
any word or phrase. In the eMail Center context, classifications are defined in the 
structured email template or in the unstructured email classification repository.

Classification set: A set of possible classifications for an unstructured message 
along with the associated metadata.

Collaboration: The process of engaging the assistance of additional people, within 
or outside the interaction center, to resolve a given interaction.

Conditional operator: The operation used to evaluate the relationship between a 
variable and a specified value.

Decision variable: The variable evaluated in the condition section of a rule.

Decision variable value: The value specified for a decision variable within a rule.

EIMS: Email Interaction Management System. A system that automatically services 
a significant proportion of incoming email interactions, intelligently routes the 
remaining interactions to the appropriate interaction center agents, provides agent 
productivity and interaction center management capabilities, and provides email 
based process automation capabilities.

eMail Center Rules API: When a new email enters the system, eMail Center will 
invoke a single eMail Center Rules API. This API will launch an eMail Center 
workflow. The eMail Center workflow will result in the email being processes. The 
eMail Center workflow may invoke eMail Center APIs in the process of processing 
the email.

The eMail Center rules workflow will be defined using Oracle Workflow Builder.

Email filtering: The application of rules to incoming or outgoing email messages to 
change the disposition of individual messages. Filtering rules normally evaluate 
conditions based on email header information and environmental conditions, and 
move the message or change its properties.
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Email format: The base format for an email message. This can be plain text, HTML, 
or XML.

Email properties: The metadata associated with an email, including all system 
defined variables associated with the email.

eMail Center Server: The eMail Center Server receives notifications from the AQ. It 
retrieves the corresponding headers, themes etc. using IM APIs. This information is 
then sent to the MMS (Multi-Media Server) as a new email interaction with the data 
as key-value pairs.

Email tag: A special marker included in an email message to identify and track the 
message.

Email type: The email type describes the level of formatting or lack thereof, of the 
message content. It can either be structured, partially structured, or unstructured.

IMAP Server: The IMAP server is one of the primary components of Internet 
Messaging. It handles all incoming emails and allows retrieval of emails by clients 
via APIs (both java and PLSQL).

IM Rules: The Internet Messaging Rules API is a PLSQL API set that is invoked by 
IM when an incoming email arrives. IM Rules are a means of having incoming 
emails trigger specific actions.

Interaction: A contact between two parties.

interMedia Text: This component represents the tables and processes that represent 
the interMediaText feature of the Oracle 8i database. 

eMail Center will make use of iMT’s theme generation (and in the future, gist 
generation) features to classify incoming emails. However, eMail Center will not 
invoke iMT APIs directly. Instead, eMail Center will invoke eMail Center APIs that 
in turn perform iMT functions.

Level of service guarantee: A commitment made by the organization to respond to 
a specified percentage of incoming interactions with a specified time period. E.g., 
respond to 95 percent of incoming emails within 5 hours.

Message Store: The message store is an Oracle database used by Internet 
Messaging to store emails and all other email related data.

Multi-Media Server: The Multi-Media Server (MMS) provides access to a common 
routing engine. It holds the agent’s state and distribution queues for all interactions 
(email, telephony, faxes, web calls).
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MMS also contains the queue summary, which is summary information about the 
number of calls in each agent’s queue organized by media type and routing 
classification.

Operations Manager: The call/interaction center manager responsible for the 
operations of the center. In terms of eMail Center the operations manager is defined 
as the ‘interaction center domain expert who also manages interaction center 
supervisors.’ The operations manager has the business process and operations 
requirements knowledge required to configure eMail Center.

Queue: A holding area for interactions before they are delivered to agents. Queues 
can either be agent queues, in which case they hold items for a single agent, or they 
can be agent group (ACD) queues that hold items for distribution to one of the 
agents belonging to the agent group.

Repository: A storage area on the file system or in a database system.

Resolved: The status associated with a closed case. It may take several interactions 
and responses to resolved a case.

Response: A reply to an incoming message that addresses the intent of the message, 
but may or may not resolve the interaction represented by the message.

Response fragments: Pieces of responses that can be added to an incomplete 
response or response template, to create a complete response.

Response template: A preformed but incomplete response that can be customized 
to create a complete response. Customization can be achieved automatically via 
merge fields and by manual modification of template contents.

Routing: The process of determining the most appropriate set of agents to service 
an individual interaction. Several routing schemes can be employed based on 
business rules and system configuration. Commonly used routing schemes are: 
message origination or delivery based routing; rules based routing; and skills based 
routing. Routing only determines the valid set of agents for that interaction and 
does not determine who the interaction should be delivered to unless only one 
agent is capable of handling the interaction in question.

Structured email: An email message that has been predefined in the system as 
being structured, and can be recognized by the system. At definition time, all the 
characteristics of the named structured email are specified, including the format, 
structured field tags, allowable values for corresponding field inputs, processing 
requirements, etc.

Structured email ID tag: A tag included in the email message that identifies the 
email as a structured email and specifies which predefined structured email it is.
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Structured email template: The template that defines all the attributes, format, 
content requirements, and processing requirements for the named structured email.

Supervisor: A ‘super-agent’ in the interaction center who manages a group of 
agents. The supervisor monitors agent and interaction center performance, assigns 
and reassigns agents to queues or tasks, and intervenes to resolve escalated 
situations.

System administrator: An information technology professional responsible for the 
implementation and system level operation of interaction center systems.

Theme: A system generated concept intended to capture the classification or intent 
of an incoming message. Themes are generated only for unstructured messages, 
since by definition, the classification and intent of structured messages is known.

Unstructured email: Any email that is not recognized by the system as being a 
structured email.

Web Form: As it is utilized in eMail Center, a Web form is the Web based interface 
for generating a structured email message. When a Web form is filled in and 
submitted, a structured email is generated and sent to the appropriate eMail Center.

Work: Synonymous with an interaction. A work item may be generated by any 
media channel, e.g., telephone, email, fax, etc.

Work blending: The delivery of inbound and outbound work items of multiple 
types (emails, phone calls, faxes, etc.) to agents. The delivery is based on 
sophisticated algorithms that implement a set of rules used to determine which 
work item a given agent should receive when the next work item is requested.

Workflow: Business process or flow needed to resolve an interaction. In the context 
of eMail Center, workflow refers to Oracle Workflow, a product that allows for 
representation and automated execution of business processes. Workflow also refers 
to the process representation delivered to the Oracle Workflow engine.

eMail Center Architecture and Tech Stack
The following main components comprise Oracle eMail Center:

        Desktop Agent Interface
A Java Server Pages (JSP) based application that runs on an agent’s desktop in a 
browser. The supported browsers are Microsoft Internet Explorer 5.0 and higher 
and Netscape Navigator 4.5 and higher. It utilizes two Java Applets, an editor 
applet that allows the user to compose messages and select the font, color, 



Other Modules, Servers and Components

Understanding Oracle eMail Center 11

formatting, etc., and it also allows importing of images (both .gif and .jpg files) and 
the second is a hidden applet, which maintains a connection with the Universal 
Work Queue Selector. This applet allows the exchange of information between eMC 
and UWQ.

System Administration Interface
A Java Server Page (JSP) based graphical user interface allows defining, viewing, 
monitoring and controlling system behavior.

Operations Configuration Interface
A Java Server Page (JSP) based graphical user interface allows authorized 
interaction center domain experts (operations managers) to configure operational 
rules or business practices for eMail Center and to specify business process 
attributes.

eMail Center Server
Is made up of a Java Server and a few database components. The Java server 
delivers information derived from an email message to the OTM server for routing 
and delivery to an appropriate agent(s). The main database component is the 
workflow based rules engine that process all inbound email messages. It can be 
customized to process emails based on different email parameters.

Oracle Email Server (OES / IM)
Is the mail server. The emails here can be accessed through JMA – IMAP APIs or 
through PL/SQL APIs.

Database Configuration
Oracle Email Server and Oracle eMail Center can be configured to be installed on 
two separate database instances or on the same instance. Both configurations are 
supported.

Other Modules, Servers and Components

CRM Foundation Modules
eMail Center uses several features of the CRM Foundation product, such as the 
common MES (Marketing Encyclopedia System), Universal Work Queue, 
One-to-One Fulfillment, and Interaction History. Of these, MES facilitates the 
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evaluation of unstructured email. The other features essentially integrate eMail 
Center with the desktop agent and the rest of CRM.

Routing Server
Routes job items (telephony and email interactions) to agents and agent groups 
based on configurable skills and rules parameters.

OTM/MCM server
The Oracle Telephony Manager, sometimes called Multi Channel Manager, holds 
the state of all the agents, and maintains the distribution queues for all interactions. 
These interactions include email, telephony, faxes, and web calls. OTM/MCM 
drives the router (actually a server, too) to determine which agents are to receive an 
email or telephone call. OTM/MCM receives the email from eMail Center and 
sends it to the router.

The output of the router is a list of agents qualified to handle the interaction. Based 
on this list, OTM/MCM distributes the email. "Distribute" in this case means that it 
puts the email into the queue of an agent, or the queue of an agent group, that the 
router identified.

This process occurs once for every new email. Although many agents might see the 
email in their queue, only one agent will service the interaction. Upon delivering 
the email to an agent, OTM/MCM removes it from all other agent queues. When an 
agent selects the email from the queue, OTM/MCM fires an event to the agent 
client desktop. When this happens, the agent might see a screen pop with a subset 
of the information contained in the email interaction.

Apache server
Apache is a third party product that handles HTML messages, such as email, 
between the source database and the agent desktop. Some Oracle CRM and ERP 
products, such as Accounts Receivable, are forms driven. They require a forms 
server to interpret and display database information. Newer CRM products, like 
eMail Center, use HTML instead of forms. The Apache server and the internet 
browser work to display the information. The Apache server manipulates HTML 
email objects between the eMail Server database, sometimes call the Message Store, 
and the agent desktop (an email client) using HTTP. The agent desktop runs an 
internet browser, such as Netscape.

Application Configuration
 These figures show a typical and an alternate configuration of the various servers.
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Email Processing
The eMail Center process flow diagram describes events that occur when the eMail 
Center handles inbound or outbound email messages, as well as events on the 
desktop during those events.

As defined earlier incoming emails can be either structured or unstructured based 
on the message content/format.

An outbound message can be a single message or a bulk mailing.

Single messages can be automatic replies to structured or unstructured inbound 
messages. Messages can also be created at the desktop by agents.

Bulk mailing is initiated by a CRM business application, such as Customer Care, 
that creates a mailing list and requests a message template.

Overview
eMail Center has three processes:

1. Inbound Server Processing.

2. Desktop Processing.

3. Outbound Server Processing.

Inbound Server Processing
Inbound processing begins when the eMail Server receives a customer message and 
passes it to the eMail Center Server.
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Customer
The customer creates an email message.

Message arrives at Oracle eMail Server

The server must be Oracle eMail Server.

Is email of type structured?

Email type can be either structured or unstructured. Structured email comes from a 
form the customer filled in on a web site or from a customer reply to an email 
questionnaire that had a structured format. In the case of a reply, the customer must 
be instructed to keep the email ID included in the original message and to answer 
the form without modifying its format.

If the email is type structured, go to Structured Message Processing

If the email is type unstructured, go to Unstructured Message Processing

Structured Message Processing
If the email is type structured, the process takes this path.

Execute structured workflow

eMail Center has one workflow, and it includes a structured path. The structured 
workflow path has several process paths available that are parallel to each other. 
The workflow process selects one of them.

Decode structured ID tag

The inbound structured email message contains an ID tag that identifies what 
structured email template it uses.

Invoke business application sub-workflow based on value of tag

eMail Center processes the email and selects the appropriate workflow based on 
specifications in the structured email. It might execute Fulfillment functions, then it 
can launch an Oracle business application, such as Customer Care.

Send automated response

(See outbound processing.) Whether or not eMail Center executes Fulfillment 
functions or launches a business application, it is capable of generating an 
automatic email response to the customer.

Unstructured Message Processing
If the email is type unstructured, the process takes this path.



Inbound Server Processing

18   Oracle eMail Center Concepts and Procedures

Extract message header information

Read the header information associated with the email. It includes the sender’s 
return address and the subject line.

Apply linguistic processing on message body & readable attachment contents

Extract readable attachments and concatenate their text to the email body. Using 
linguistic processing, generate themes for the concatenated message.

Generate classifications

Analyze the themes, comparing them to classification theme signatures in the 
classification table. Select the top classification matches.

Select suggested responses from the knowledge base for each classification

Suggest responses for the top classification matches. Do this by using a mix of the 
theme signatures identified in the email and theme signatures of the top 
classification matches. With the theme signature mix, get suggested responses from 
the knowledge bases, MES and SMS.

Is top classification score greater than the auto-response classification threshold?

If the classification score inspires confidence, then go to the next test.

If the classification score does not inspire confidence, route the message to an agent. 
Go to Route message to appropriate agents.

Is the associated top suggested response score greater than the auto-response 
response selection threshold?

If the response score inspires confidence, send the response. Go to Send automated 
response (see outbound processing).

Route message to appropriate agents

If either the classification score or the suggested response score do not inspire 
confidence -- were not greater than the respective threshold -- send the message to 
an agent for handling.

Send automated response (see outbound processing)
If both the classification score and the suggested response score do inspire 
confidence, send the response if auto-response is not turned off. It does not require 
agent intervention.
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Desktop Processing
Desktop processing begins the first time when the agent requests an email work 
item in the Universal Work Queue (UWQ). It repeats itself each time the agent 
requests another email item.

The desktop process can handle either inbound email or outbound email. Inbound 
email normally is unstructured. Structured email does not require agent 
intervention unless the template is missing or an error occurs. The only outbound 
email the agent handles is that which the agent initiated manually. Outbound email 
generated by a business application does not require agent intervention.
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Agent Desktop
In an interaction center, agents can be assigned to multiple communications media, 
including inbound telephone calls, outbound telephone calls, and email. In this 
scenario, either the supervisor, the agent, or Oracle Interaction Blending indicate 
that the agent is working with email. 

The agent begins working with email by requesting an email item from the 
Universal Work Queue.

At the end of the each email item the Desktop Processing loop returns to this point 
and presents the agent with two options:

■ Agent requests next email work item in Universal Work Queue

■ Agent views folders / messages screen in the eMC (eMail Center) Application

Agent requests next email work item in Universal Work Queue
The agent begins one email cycle by requesting an email item from the UWQ.

Is the previous interaction ended in the business application?

Normally the agent handles only one customer interaction at a time. If Customer 
Care or some other business application still has an open interaction, it must close 
the interaction before UWQ will issue an email item to the agent.

Select message in folder

If no interaction is open, then the agent can select a message from one of the folders.

Email and associated meta data delivered to eMC application and business 
application

eMail Center releases an email item to the agent. This includes the meta data, which 
is message header information and other properties.

Business application "popped" with customer information

If the agent is in a business application, such as Oracle Customer Care, eMail Center 
sends the message to that application. The message meta data frequently contains 
enough information for the business application to find the customer’s record -- 
assuming an existing customer -- and pops it on the screen.

Agent views the preview screen

The agent can preview the message before responding to it by clicking the subject of 
the message in the inbox. At this point, the agent is looking at a preview of the 
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email message, and has not taken any action on it. The agent could cancel the 
preview and request another email item.

The agent has several options to choose amongst that include:

■ Forward email

Forward the email outside eMail Center or outside the interaction center.

■ Transfer email

Transfer the email to another agent handling the same account. For example, an 
agent assigned to the "Support" account can only transfer emails to other agents 
handling the "Support" account.

■ Reroute email

Reroute the email to another agent queue. This might indicate that the 
workflow has an error in its agent group routing.

■ Print email

Print the email and return to the preview.

■ Delete email

Delete the email and return the agent to a display of email folders and message 
screens. Go to Agent views folders / messages screen in the eMC Application.

■ Cancel preview

Cancel the preview without taking any action. Return the agent to a display of 
email folders and message screens. Go to Agent views folders / messages 
screen in the eMC Application

■ Respond

Take action on the email. Go to Agent selects Respond and views the eMC 
response screen.

Agent selects Respond and views the eMC response screen

In choosing to respond to the email, the agent has several choices, including:

■ Accept the suggested classification and response. This leads to three nodes in 
the process flow:

■ Select Classification

■ Select suggested response

■ Insert/Attach suggested response
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These steps are self explanatory. The agent can repeat them several times 
for each issue marked up in a multi-issue email, and for as many 
classifications and responses as are available in the suggestion lists.

■ Attach desktop document

■ Customize the response

■ The agent can customize the response by typing free form text using the 
full-featured editor available. The agent may also wish to respond to the 
message manually rather than use a suggested response. In this case the 
agent either type the message or can select a "template" from the standard 
set of templates available. 

■ Search KB (knowledge base) and attach / insert KB document

These three options, Attach, Type, and Search, also are self explanatory. They 
present three options in the process flow as well:

■ Edit email headers (subject, addresses) and select ’Send’

When the agent selects Send, the email is sent to the node labeled, To 
Outbound Server Processing (Insert message tracking information)

■ Select ’Cooperate’ and send transfer mail and partial response to another 
agent

■ Save message

On completing each of these three options, Edit, Cooperate, or Save, the 
process flow takes the agent to the node, End interaction in business flow.

End interaction in business application

This is the end of one email item process cycle. The agent starts another cycle in one 
of the first nodes: 

■ Agent views folders / messages screen in the eMC Application

■ Agent requests next email work item in Universal Work Queue

Agent views folders / messages screen in the eMC Application
This is an alternate point for the agent to begin an email cycle, the first being Agent 
requests next email work item in Universal Work Queue. 

If the agent chooses this path, the Desktop Process offers these options:

■ Select message in folder
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■ Select email history tab and view email history

■ Select knowledge base (KB) tab to navigate and search the KB

■ Add email folder

■ Delete email folder

■ Refresh

■ Acquire new emails

■ Select All 

■ Deselect All

■ Move emails between subfolders

■ Compose new message

These options are self explanatory. When the selected option is completed, the 
Desktop Process returns the agent to this node.

One of the options, Compose new message, takes the agent though several 
process nodes before returning to this node.

Select Message in folder

This entry in the description is repeating an option of its parent node. It is needed to 
continue describing the process of this node.

If the agent selects a message in the folder, Desktop Processing routes the agent to 
the same flow path described earlier: 

■ Go to the first node, labeled Agent requests next email work item in Universal 
Work Queue, and 

■ Look at the next step in the Desktop Processing, labeled Is the previous 
interaction ended in the business application? The process follows that path.

Compose new message

This entry in the description is repeating an option of its parent node. It is needed to 
continue describing the process of this node.

If the agent chooses to compose a new message, Desktop Processing offers these 
options (they are similar to, but slightly different from, the options offered by the 
Agent selects Respond and views the eMC response screen node):

■ Attach desktop document

■ Type response text
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When selecting to respond manually, the agent has two options not shown in 
the process flow:

■ Respond to messages manually, typing free form text

■ Respond to messages using a response template. Here the agent manually 
selects a template category. Then the Merge screen appears with a list of 
suggested responses under the selected template category.

■ Search KB (knowledge base) and attach / insert KB document

These three options, Attach, Type, and Search, also are self explanatory. They 
present three options in the process flow as well:

■ Edit email headers (subject, addresses) and select ’Send’

When the agent selects Send, the email is sent to the node labeled, To 
Outbound Server Processing (Insert message tracking information)

■ Select ’Cooperate’ and send transfer mail and partial response to another 
agent

■ Save message

On completing each of these three options, Edit, Cooperate, or Save, the 
process flow takes the agent to the node, End interaction in business flow.

End interaction in business application

This is the end of one email item process cycle. The agent starts another cycle in one 
of the first nodes: 

■ Agent views folders / messages screen in the eMC Application

■ Agent requests next email work item in Universal Work Queue

To Outbound Server Processing (Insert message tracking information)
This node points to the Outbound Server Processing flow chart. In that flow chart, 
the process continues immediately at the Insert message tracking information 
node in Send Response.

Outbound Server Processing
Outbound Processing can begin one of three ways: 

■ It can begin when a business application, such as Customer Care, starts a bulk 
mailing campaign. 
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■ In that same business application, an agent or a process can create a single email 
message, also causing Outbound Processing to begin.

■ Earlier in this document, Desktop Processing caused Outbound Processing to 
begin when an agent selected the Send option either while responding to an 
inbound email or while creating a new email.

The Outbound Process has a single path with three entry points:

■ Business application creates a mailing list

The business application is executing a bulk mailing campaign.

■ Application sends outbound request to eMC (eMail Center server)

The business application is sending a single message.

■ Insert message tracking information

The agent selected Send in Desktop Processing while responding to an inbound 
email or while composing a new email.

This description starts at the beginning of the Outbound Processing path and 
continues to the end.

Business Application
A business application, such as Customer Care, starts a bulk mailing campaign, or 
an agent or a process creates a single campaign.

Bulk Mailing
This is the first entry point. The business application starts a bulk mailing 
campaign.
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Business application creates a mailing list

In this node, the business application has created a mailing list, probably by 
querying the customer database and merging the appropriate information with a 
mailing label form.

Single Message
This is the second entry point. In the business application an agent or a process 
created an email message.

Application sends outbound request to eMC

Obviously the single message is inserted here.

Send Response
Send Response is a group of nodes in the eMail Center process that generates a 
message, one at a time in the case of bulk mailing, to be sent to the eMail Server on 
its way to the customer.

The group of Send Response nodes are:

■ Select message template

■ Expand personalization / merge fields

■ Populate header information

Header information includes the customer’s email address in the To field and a 
title for the Subject field.

■ Insert message tracking information

This is the third entry point into the Outbound Processing path. Desktop 
Processing generated this information and inserted it here.

■ Send message

The eMail Center Server sends the message to the eMail Server.

Web Server HTML Form Processing
The following diagram depicts how the web server processes HTML forms.
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Overview of System Process Flows
Click one of the following to view its system process flow diagram:

Inbound Process Flow

Unstructured Email Processing

Routing, Queuing, and Delivery

Web Form Processing

Structured Email Processing

Desktop Interaction Delivery

Automated Outbound Processing
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Inbound Process Flow
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Unstructured Email Processing

Theme Matching Repositories Include:
■ Response template repository

■ Previous responses repository

■ MES

■ Support knowledge base

■ User defined repositories
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Routing, Queuing, and Delivery
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Web Form Processing
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Structured Email Processing

Desktop Interaction Delivery
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Knowledge Repositories Accessible From the Agent Desktop Include:
■ Response template repository

■ Previous responses repository

■ MES

■ Support knowledge base

■ User defined repositories

Automated Outbound Processing

Usage Scenarios
The following scenarios are described here to illustrate eMail Center usage 
potential.

eMail Center Usage Options
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eMail Center Email Processing Options

Inbound Scenarios

Scenario 1: Unstructured email – service request
Customer composes message (using any email client) to company describing 
problem with customer account and requesting resolution

Interaction Initiated... Interaction Resolution Inbound Scenarios

By Customer

     -using web form

     -using email client

Automatically, without 
human intervention

For interactions that cannot be 
resolved automatically:

      -generate suggested responses and 
route to CSR

By business application or 
other system (including 
another eMail Center)

Responses generated 
automatically, but human 
intervention used for 
verification and 
modification

For interactions that can be partially or 
fully satisfied automatically:

      -invoke business application to 
deliver self-service or

      -invoke knowledge management 
system to deliver automated service 
request resolution or

      -collaborate with another eMail 
Center to enable self-service or

      -automatically satisfy requests that 
can be fully addressed by available 
documents or canned responses

By CC agent (CSR) Manually, by CC agent

Email Type Inbound Options Outbound Options

Structured

-Send to CRM/ERM application

-Send to knowledge management 
system

-Retrieve response documents from 
document repository

-Collaborate with another eMail Center

-Send to agent (CSR)

-Combinations of the above

-Notification initiated by 
CRM/ERM application

-Campaign or other bulk mailing

-Agent generates messages

Unstructured

-Retrieve response documents

-Send to agent (CSR)

-Retrieve response documents and send 
to agent

-Not recommended



Inbound Scenarios

36   Oracle eMail Center Concepts and Procedures

1. Email client sends free-form email to company. Email is received by the 
company’s eMail Center.

2. eMail Center gets customer information and generates classifications for the 
email message based on known classifications.

3. Responses are composed for each of the potential classifications.

4. Email along with pre-composed suggested responses are routed to the 
appropriate agent (CSR).

5. CSR resolves problem and sends reply to customer.

Scenario 2: Structured email – order submission
Customer places order for product on company Web site – need to get product 
availability and shipping time information from supplier’s system

1. Structured email sent to eMail Center.

2. eMail Center processes the email and selects the appropriate workflow based 
on specification in the structured email template for order submissions for the 
specified product.

3. eMail Center creates and sends a structured email message to the supplier’s 
eMail Center requesting availability and shipping time for ordered product 
(distributor’s eMail Center selects appropriate remote workflow).

4. Based on response from supplier’s eMail Center, the company’s eMail Center 
creates enters the order into the system.

5. An email response is sent to the customer’s address, providing details for the 
purchase.

Scenario 3: Structured email – collateral request
Customer cannot find product collateral on company Web site -- requests it.

1. Structured email sent to eMail Center.

2. eMail Center processes the email and selects the appropriate workflow based 
on specification in the structured email template for the collateral request.

3. The workflow selects the appropriate documents from the document repository.

4. eMail Center automatically composes the response and attaches the requested 
product collateral to the response.

5. The response is automatically sent out to the customer.
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Scenario 4: Structured email – problem report
Customer fills in Web form to report problem with previously purchased product

1. Structured email sent to eMail Center.

2. eMail Center processes the email and selects the appropriate workflow based 
on specification in the associated structured email template.

3. The workflow process creates a service request by calling the appropriate APIs 
for the service application.

4. The problem report information is then sent to the knowledge management 
system which either finds a solution (or set of solutions) to the problem, 
specifies additional information need to find the solution, or cannot converge 
on a solution.

5. If the system finds a solution or specifies additional information needed, the 
system can generate the corresponding message and send it to the customer.

6. If not, the interaction is routed to a live agent who resolves the problem and 
send an email response to the customer.

Outbound Scenarios

Scenario 1: Outbound interaction – email notification
Payment is overdue, business application needs to send email reminder to customer

1. Business application detects that customer’s payment is overdue and generates 
a request to eMail Center to send out a notification to the customer.

2. Business application request includes information regarding the message 
template to be selected, customer information, and email delivery options.

3. eMail Center uses request information to compose the email, expand any merge 
fields in the message template, and send the notification to the customer.

4. The outgoing email is tagged to uniquely identify the message and its 
associated intent / classification so that any responses to the message can be 
accurately classified and processed accordingly.

Scenario 2: Outbound interaction – email campaign
Company targets selected customers for email based sales promotion campaign

1. The campaign is defined in the sales automation application.
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2. The sales automation application sends a request to execute the email campaign 
to eMail Center.

3. The request contains information about the email template to be used, the 
campaign identification information, and the response processing rules, along 
with the list of customers / prospects and associated information.

4. eMail Center creates individual email messages to all the addressees in the 
campaign list, tags the messages individually, and sends the messages to the 
target audience.

5. Response to the campaign mailing are tracked and processed according to rules 
defined for that particular campaign.

Scenario 3: Outbound interaction – agent initiated
CSR creates new message to follow up on phone conversation with customer

1. Agent selects the message template and fills in the relevant information.

2. Agent modifies message sending options if necessary and selects the 
classification and processing rules for responses to the message.

3. Message is sent out the customer, and any responses are tracked and processed 
according to the specified processing rules.

Processing Overview
This overview is intended to provide a sense for the processing that needs to occur 
within the product. The description does not cover all the steps associated with 
eMail Center’s processing of email interactions. Processing steps in the actual 
product could be significantly different from those described here, if additional 
architectural or design work dictates the need to add, delete, or modify processing 
steps.

Click one of the following topics to view more information:

Inbound Processing

Outbound Processing

Inbound Processing
eMail Center accepts structured as well as unstructured emails. It either recognizes 
an inbound email as corresponding to one of the pre-registered structured 
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templates or it attempts to map the inbound email to and transform it into a 
pre-registered structured template.

Structured Email
If the incoming email is successfully classified as a recognized structured email, the 
information in it is packaged and delivered to the appropriate workflow that 
automates the business process required to satisfy the interaction. The outcome of 
the business process can be sent back to eMail Center and an appropriate response 
can be automatically created and sent back to the entity (computer system or 
human being) that initiated the original interaction.

Unstructured Email
For an incoming email that cannot be successfully classified as a recognized 
structured email, the eMail Center attempts to match the themes generated for the 
email with themes for:

■ pre-defined structured email templates

■ pre-classified unstructured email request examples

■ items in the document repository 

■ pre-defined response templates 

■ responses to previous interactions

■ items in user-defined repositories to classify the email. Classification can also be 
assigned based on user-configured rules.

Based on this classification, ranked (and scored) suggested responses are 
formulated and the original email, along with the suggested responses, are routed 
to the most appropriate agent based on various routing schemes (rules based, skills 
based, etc.), agent availability and user defined business rules. 

Agents then have the ability to redirect the inbound interaction to another agent, 
satisfy the interaction themselves, specify a workflow to collaborate with others in 
the organization to satisfy the interaction, or specify a workflow to automate a 
business process.

Outbound Processing
Outbound interactions can be automatically created notifications generated by 
business application or campaign mailings; or messages initiated and composed by 
someone logged in to eMail Center (agent or supervisor).
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For outbound notifications, the request is delivered to eMail Center by the business 
application via an Advanced Queuing queue in the database. The request contains 
all the information necessary to create the email message in eMail Center.

eMail Center extracts the information and creates and sends the message based on 
this information.

The message template to be used for the email notification is first selected. The 
appropriate merge fields in the template are then filled in and additional message 
content fragments and information associated with the addressee are fetched from 
the appropriate repositories and included in the message.

eMail Center then sets the message sending options associated with the message 
and inserts the appropriate tracking tags into the email. Outbound message filters 
are then applied to the message (to enforce business rules for outgoing messages) 
and the message is sent to the addressee.

Responses to the message are tracked and processed according to the rules defined 
in the notification request.

For email campaign execution requests, a list of addressees an associated 
information is provided to eMail Center, which creates individual messages for each 
entry in the list, and sends out the emails as described above. Responses to 
campaign mailings are processed based on rules defined in the campaign execution 
request.

For agent initiated outbound interactions, a process similar to the ones described 
above is initiated. For these cases, the agent, rather than the system selects the 
appropriate template, modified the default message sending options, and inserts 
the appropriate content into the message. Other steps in the process are carried out 
by the system.
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Using Oracle eMail Center

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

This topic group covers the following topics:

Viewing and Modifying Agent Preferences

Viewing Messages

Responding to Messages

Responding to Messages Manually

Responding to Messages Using a Response Template

Printing Messages

Searching for Messages

Sorting Messages in Your Mailbox

Composing Messages

Selecting Text Formatting

Deleting Messages

Cooperating With Other Agents

Viewing and Modifying Agent Preferences
Use this procedure to view and modify agent preferences.

Prerequisites
A valid login ID must be set up for you by the system administrator before you can 
view or modify preferences.

Steps
1. Click the Preference tab to display your preferences.

2. View and modify your preferences.
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3. Click Apply.

 The Preference screen updates to display your new preferences.

4. Click OK to return to the My Messages screen.

References
Viewing Messages

Responding to Messages

Printing Messages

Composing Messages

Deleting Messages

Cooperating With Other Agents

Viewing Messages
Use this procedure to view messages.

Prerequisites
A valid login ID must be set up for you by the system administrator before you can 
view messages.

Steps
1. Click the Messages tab.

The My Email Messages screen appears.

2. Click the desired folder in the Folder List tree.

The messages in the selected folder display.

References
Viewing and Modifying Agent Preferences

Responding to Messages

Printing Messages

Composing Messages

Deleting Messages
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Cooperating With Other Agents

Responding to Messages
eMail Center allows you to respond to messages in several ways. You can type a 
manual response, or select from a list of response templates that automatically 
provide text for a response.

Select one of the following for more information:

Responding to Messages Manually

Responding to Messages Using a Response Template

Responding to Messages Manually
Use this procedure to manually respond to messages.

Prerequisites
A valid login ID must be set up for you by the system administrator before you can 
respond to messages.

Steps
1. Click the subject heading of the desired message.

The Respond screen appears, with the sender’s name already typed in the To 
field and the subject heading already typed in the Subject field.

2. Type your response in the provided field.

3. Click Send.

References
Viewing and Modifying Agent Preferences

Viewing Messages

Responding to Messages

Printing Messages

Composing Messages

Deleting Messages
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Cooperating With Other Agents

Responding to Messages Using a Response Template
Use this procedure to respond to messages using a response template.

Prerequisites
A valid login ID must be set up for you by the system administrator before you can 
respond to messages.

Steps
1. When viewing the email message, click Respond.

The Respond screen appears, with the sender’s name already typed in the To 
field and the subject heading already typed in the Subject field.

2. From the classification category list, click the classification category that most 
closely matches the desired response.

The pop-up screen appears with a list of the suggested responses under the 
selected template category.

3. From the Suggested Responses list, click the response title that most closely 
matches your desired response.

4. Type the required data (if applicable) in the fields provided.

5. Click Insert. 

eMail Center inserts the template text into the specific information in the email 
message and displays the merged response.

6. If you wish to provide additional information, click the Insert or Attach button 
(depending on how you want the information attached to the email).

The additional information message is inserted or attached to the original email 
message.

Note: eMail Center automatically ranks or scores the suggested 
responses on a scale of one to one hundred percent, based on key 
words in the message body.
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7. Click Send to send the message.

References
Viewing and Modifying Agent Preferences

Viewing Messages

Responding to Messages

Printing Messages

Composing Messages

Deleting Messages

Cooperating With Other Agents

Printing Messages
Use this procedure to print messages.

Prerequisites
A valid login ID must be set up for you by the system administrator before you can 
print messages.

Steps
1. Click the desired message to view it. 

The Preview screen appears, displaying the selected email.

2. Click Print. 

The Print Mail screen appears.

3. Click the appropriate checkbox and click OK.

The email prints on the designated printer.

Note: If you elect to send the information as an attachment to the 
email, eMail Center asks you to provide a filename for the 
attachment.
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References
Viewing and Modifying Agent Preferences

Viewing Messages

Responding to Messages

Searching for Messages

Composing Messages

Deleting Messages

Searching for Messages
Use this procedure to search for messages.

Prerequisites
A valid login ID must be set up for you by the system administrator before you can 
search for messages.

Steps
1. From the My Email Messages screen, click Acquire Messages.

2. Your mailbox updates to reflect new messages.

References
Viewing and Modifying Agent Preferences

Viewing Messages

Responding to Messages

Printing Messages

Composing Messages

Deleting Messages

Sorting Messages in Your Mailbox
eMail Center provides several ways to sort or filter the messages in your mailbox. 
You can sort in ascending or descending order by any of the following:

■ From - sorts alphabetically (A to Z / Z to A)
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■ Subject - sorts alphabetically by first letter of subject heading

■ Date Sent - sorts by the date the email was sent (most recent /least recent)

■ Status - sorts by the assigned status of the email (highest to lowest / lowest to 
highest)

■ Classification - sorts by the classification level

Use this procedure to sort messages in your mailbox.

Prerequisites
A valid login ID must be set up for you by the system administrator before you can 
sort messages.

Steps
1. From the My Email Messages screen, click the desired column heading (From, 

Subject, Date Sent, Status, or Classification).

A small triangle appears next to the selected column header.

2. Click the triangle to switch between ascending and descending order for the 
sort.

The triangle will point in the direction of the selected sort order (up or down).

References
Viewing and Modifying Agent Preferences

Viewing Messages

Responding to Messages

Printing Messages

Composing Messages

Deleting Messages

Composing Messages
Use this procedure to compose new email messages.
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Prerequisites
A valid login ID must be set up for you by the system administrator before you can 
send messages.

Steps
1. From the My Email Messages screen, click Compose.

The Compose screen appears.

2. From the template bin on the upper left-hand side of hte screen, click the 
topmost template.

The template is inserted into the email response.

3. If you wish to customize the email message, type the desired text in the 
response field.

4. If you wish to attach a document to the message, click Attach.

A pop-up screen appears.

5. Navigate to the folder in which the desired document is stored and click the 
document.

6. Click Open.

7. Click Attach.

The selected document name will appear below the email message 

8. Click To to select the recipient of the email from your address list. If the 
recipient’s address is not in your list, simply type it in the To field.

9. If you wish to copy another person on the email, click the Cc button and select 
the desired address from the list, or simply type it in the Cc field.

10. if youwish to customize the subject heading for the message, type a subject 
heading in the Subject field.

11. If you wish to customize the formatting of the message, select the desired text 
formatting options.

12. Click Send to send the message.

References
Viewing Messages

Responding to Messages
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Printing Messages

Selecting Text Formatting

Deleting Messages

Cooperating With Other Agents

Selecting Text Formatting
eMail Center allows you to format your email message text in a wide range of fonts, 
font sizes, font styles, and colors.

Use this procedure to select text formatting for email messages.

Prerequisites
A valid login ID must be set up for you by the system administrator before you can 
format message text. To format text, you must either be responding to an email or 
sending a new email.

Steps
1. Click Font Name to select the font for your text. If you have already typed in a 

message, highlight the text before clicking Font Name.

2. Click the desired font from the drop down list.

The selected font name appears on the Font Name button. If you highlighted 
text, the text switches to the selected font.

3. Click Font Size to select the font size for your text. If you have already typed in 
a message, highlight the text before clicking Font Size.

4. Click the desired font size from the drop down list. 

The selected font size appears on the Font Size button. If you highlighted text, 
the text switches to the selected font size.

References
Viewing Messages

Responding to Messages

Printing Messages

Composing Messages
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Deleting Messages

Deleting Messages
Use this procedure to delete messages.

Prerequisites
A valid login ID must be set up for you by the system administrator before you can 
delete messages.

Steps
1. From the My Email Messages screen, click the checkbox in the Select column 

next to the message you wish to delete.

2. Click Delete to delete the selected message.

References
Viewing Messages

Responding to Messages

Printing Messages

Composing Messages

Selecting Text Formatting

Cooperating With Other Agents
Use this procedure to cooperate with other agents when responding to an email.

Prerequisites
A valid login ID must be set up for you by the system administrator before you can 
cooperate with other agents.

Note: You can delete more than one message at a time. To do so, 
click the checkbox in the Select column next to each message you 
wish to delete, then click Delete.
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Steps
1. From the Respond screen, click Cooperate.

The Available Contacts screen appears.

2. In the Select an Agent field, type the name of the agent with whom you wish to 
cooperate and click Go!.

The selected email message forwards to the designated agent.

References
Viewing Messages

Responding to Messages

Printing Messages

Composing Messages

Selecting Text Formatting

Implementing Oracle eMail Center

This section provides setup and configuration tasks required to successfully 
implement Oracle eMail Center.

This section covers the following topic groups:

■ Planning the Implementation

■ Integration Dependencies

■ Post-Installation Steps

■ Implementation

■ Troubleshooting

Note: The Available Contacts list displays the name and role of all 
available agents.
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Planning the Implementation
Implementing Oracle eMail Center is a complex process that requires knowledge of 
a variety of technologies and processes. Persons implementing Oracle eMail Center 
should have a working knowledge of Oracle Forms, HTML, Java, and the 
installation platform (Windows NT or Unix), in addition to an understanding of the 
operational requirements of an interaction center.

This topic group contains a diagram of the implementation process and an 
implementation planning questionnaire that will help you determine and collect 
information you will need during the implementation process.

The Implementation Process
The following diagram depicts the implementation process for eMail Center:
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Implementation Planning Questionnaire
The following questions provide a high level overview of the information necessary 
to successfully implement Oracle eMail Center. This is information that should be 
decided upon prior to beginning the implementation process.



Implementation Planning Questionnaire

54   Oracle eMail Center Concepts and Procedures

Use the following questionnaire to gather information crucial to the implementation 
process:

1. Single instance (default) or multiple instances?

2. What email accounts need to be defined in OES?

■ These are the email accounts to which inbound email will be directed. 
Examples could be: support@company.com, info@company.com, 
promotions@company.com, sales@company.com, etc.

3. Which agents should be able to process emails directed to each account?

4. What agent groups need to be defined for each account?

5. For each account, what’s the set of classifications that covers all emails?

■ These classifications are essentially labels for the buckets into which the 
customer wants to sort incoming emails. Classifications can be used to 
route individual emails to agents as well as select the appropriate responses 
from the knowledge base. Ideally, the subject matter in emails for each 
classification should be mutually exclusive and collectively exhaustive.

6. What are good sample messages for each classification?

■ Does the customer already have sample data? Do you need to create 
samples for classifications? Do the samples completely represent the 
different subject matter anticipated in emails belonging to the classification?

7. What are good sample responses for each classification?

■ Does the customer already have sample data? Do you need to create 
samples for classifications? Do the samples completely represent the 
different types of responses for the classification? Ideally, there should be at 
least one sample response for each sample message

8. Where is the customer’s knowledge base data?

■ How do you upload this data into the Oracle knowledge bases (MES or 
SMS)? How should the data base be organized in MES (under what user 
defined categories within the eMC system defined partitions (Suggested 
Responses, Templates, etc.)?

9. What thresholds should be set for confidence scores on incoming message 
classification and suggested responses to trigger automated responses?

10. What static routing rules need to be defined?

■ What should be the destination agents / agent groups for each static route?
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11. What dynamic routing procedures / workflows need to be developed?

■ What are the implementation details for creating the stored procedures / 
workflows?

12. What are the business requirements for processing unstructured emails?

■ What are the rules for automatically redirecting an incoming message to 
another account (on the same email server or a different one)? What are the 
rules for determining when to send an auto-acknowledgement and 
selecting the response for the auto-acknowledgement? What information 
from the CRM DB needs to be extracted to make processing decisions for an 
email message? What information should the system look for in the 
incoming message to use in rules processing?

13. What customer data needs to be displayed in the eMC Desktop Customer 
Profile area?

■ This data is retrieved from the desktop business application (Customer 
Care / Contact Center, Telesales, etc.)

14. What is the maximum number of suggested classification to be displayed in the 
eMC Desktop? (System maximum is seven)

15. What is the maximum number of suggested responses to be displayed for each 
suggested classification?

16. What MES categories should be searched to get suggested responses for each 
account?

17. What are the default outbound email header values for each account?

■ From address, reply-to address, extended header tags, etc.

18. How should bounced messages and other responses to tagged emails be 
handled?

■ Responses routed directly to the agent who sent out the message, or routed 
according to the routing server rules? Notify sending application on 
message bounce / auto-response? etc.

19. What should be the default message format for outgoing messages (plain text, 
HTML, or both?)

20. What keywords or key phrases in the headers or contents of a message indicate 
that determine which eMC account a message belongs to? 
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■ E.g., a message with the key phrase ‘service request’ belongs in the 
‘support’ account, and if it was sent to the ‘info@company.com’ account it 
should be redirected to ‘support@company.com’.

Integration Dependencies
This topic group contains a list of the core products with which Oracle eMail Center 
integrates and a brief description or each core product, including:

■ Email Server (OES/IM)

■ interMediaText (iMT)

■ Telephony Manager (OTM/MCM)

■ Routing Server

■ Work Blending

■ Universal Work Queue

■ Interaction History

■ Forms Business Application

■ Fulfillment Server

■ Knowledge Management System (KMS)

■ Concurrent Manager

Oracle Email Server (OES / IM)
Oracle Email Server (Internet Messaging) is the core email system. The native email 
functionality is supported by this system. OES has both PL/SQL and IMAP 
interfaces and is bundled with the Sendmail implementation of SMTP service.

The topics in this section describe the important sub-components of the Email 
Server, including:

■ IMAP Server

■ Message Store

■ SMTP Server

■ OES PL/SQL APIs
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Known Limitations:
■ Oracle eMail Center is tightly integrated with this product. Other Email 

Services, existing or new, must integrate with this product.

■ Spam and Virus check features are currently missing.

■ Email encryption/decryption features are missing in the OES release 5.1.x.

■ Oracle interMedia Text’s linguistic processing currently work only on English 
text. Other languages are being supported in the future releases.

Platform Dependencies:
■ OES and its components are ported to most major platforms.

Configuration Options:
■ Oracle eMail Center can integrate to multiple instances of OES. In some cases 

there will be multiple instances of OES Message store, which share a common 
IMAP server and SMTP components.

IMAP Server
OES implements the server section of the IMAP protocol. The server is mainly used 
by the IMAP implementation of JMA (middle tier) to access emails stored in the 
Message Store.

Message Store
The Message Store resides in an Oracle database (8.1.6), and it is a collection of 
database tables and stored procedures that implement the various email specific 
operations. Email accounts including folders, all incoming emails, and all outgoing 
emails are stored here.

SMTP Server
Currently OES is bundled with the Sendmail’s implementation of the SMTP 
protocol. Various options like third party spam and virus checks can be added to 
make a more robust system.
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OES PL/SQL APIs
The OES PL/SQL APIs extend the normal email functionality to implement rule 
based notifications, account maintenance, and interMedia Text (iMT) processing of 
incoming email messages. This additional functionality results in a close integration 
with the OES product.

Oracle interMediaText (iMT)
Oracle interMedia Text is a text/linguistic-processing module bundled as a 
component of Oracle 8.x database. It is mainly used to determine the intent of each 
incoming email message.

Known Limitations
■ Oracle interMedia Text’s linguistic processing currently work only on English 

text. Other languages are being supported in the future releases.

■ Only bundled with Oracle 8 and higher versions. Not available on earlier 
versions.

Platform Dependencies
■ Ported to most major platforms.

Configuration Options
■ You can customize the linguistic processing module by modifying the theme 

and iMT Knowledge Base sections. This focuses the linguistic processor to look 
for more relevant information and enables you to fine-tune email processing.

Oracle Telephony Manager (OTM/MCM)
The Oracle Telephony Manager maintains the agent distribution queues and agent 
states for any Interaction Center. It also provides access to a common routing 
engine. OTM is media independent and can route all types of interactions (email, 
telephony, faxes, web calls) to the call center agents.

Known Limitations
■ Only one OTM server can exist per Interaction Center.
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Platform Dependencies
■ A Java Server; Runs on Solaris and NT platforms.

Configuration Options
■ There is a 1:1 relationship between an OTM and an eMC Server; however, the 

rest of the eMail Center modules are shared.

Routing Server
The Routing Server determines which agent(s)/agent groups get a new interaction. 
The routing can be skill and/or rule based. The routes are defined for various 
classifications and parameters.

Platform Dependencies
■ A Java Server; Runs on Solaris and NT platforms.

Work Blending
The Work Blending server determines the type (email, phone call, fax, etc.) of 
interaction an agent should service next. To make this determination, Work 
Blending obtains real time information about the agent from UWQ.

Universal Work Queue
UWQ Client and Server code work in unison to do the following:

1. Relay information between MCM and the Forms Application.

2. Capture certain information for statistical purposes.

3. Capture certain information for work blending purposes.

UWQ also works in conjunction with Work Blending to determine what type of 
interaction the agent should service next.

Platform Dependencies
■ A Java Server; Runs on Solaris and NT platforms.
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Interaction History (IH)
The Interaction History maintains all interaction life-cycle segments, i.e. accounts 
for the entire time duration beginning at the moment an Interaction (fax, phone call, 
email.) is registered in the system to the instant it is resolved. This is a cumulative 
record of all interactions passing through the system. It also records information 
about various agents who handled the interaction in the recorded time duration.

Forms Business Application
This can be any Oracle CRM Forms application (Oracle Service, Oracle TeleSales, 
Customer Care). These forms applications embed the UWQ client, enabling them to 
work with the Oracle eMail Center Desktop Client. This is done via Java socket 
communication between the UWQ client and the eMC Desktop Client. The business 
applications contain the necessary profiles and business intelligence.

Fulfillment Server
Fulfillment Server is a part of Oracle CRM Foundation. This service enables various 
applications to fulfill/complete various pending tasks. For eMail Center, this service 
enables eMC to automatically send out single and/or bulk emails.

Knowledge Management Systems (KMS)
At present, the Knowledge Management system consists of SMS and MES. All KMS 
interactions are channeled through the SMS system which exposes a single set of 
APIs hiding the complexity of the various sub-systems. Both PL/SQL and Java APIs 
exist to enable interMedia based queries and retrievals.

■ Solution Management System

■ Marketing Encyclopedia System

Platform Dependencies
■ A database module; Oracle 8.x ported to most platforms.

Solution Management System (SMS)
A repository of problem, diagnosis, related symptoms and their solutions.
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Marketing Encyclopedia Systems (MES/KB)
MES is also known as the Knowledge Base (KB). It is a repository of various 
documents, URL, images and such. MES is partitioned into various application 
spaces, each application (e.g Tele-Sales, Oracle eMC, etc.) can store documents, 
URLs, images and such in its own private space in this system. Various PL/SQL 
and Java APIs and a JSP UI exists to create/upload, list, categorize and order these 
entities.

Concurrent Manager
Concurrent Manager is a component of Oracle Application Object Library. It is 
responsible for scheduling and running various concurrent programs submitted by 
the user. It uses Distributed Concurrent Processing and can simultaneously run 
concurrent requests on several different server machines or CPUs. Oracle eMail 
Center makes use of this facility to schedule and run various email processing 
modules.

Platform Dependencies
■ A database module; Oracle 8.x ported to most platforms.

Post-Installation Steps
Two post-installation procedures are necessary for the eMail Center server side. The 
first procedure consists of installing and configuring the Email Server. The second 
procedure involves installing and configuring the eMC Server. For the second 
process, you will need the Oracle Call Center Applications Setup CD.

Installing and Configuring Oracle Email Server (OES)

Installing and Configuring Oracle eMail Center Server (eMC)

Installing and Configuring Oracle Email Server (OES)
Use this procedure to install and configure Oracle Email Server.

Prerequisites
Before configuring the Email Server, you should complete the initial Rapid Install 
process. The Oracle Email Server documentation provides detailed instructions on 
installing Email Server with Rapid Install.
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Steps
1. Install Oracle Email Server (OES) 5.1 (patchset 3) on the same or on a separate 

instance as the Oracle Applications Instance. Follow the instructions provided 
in the Oracle Email Server Installation Guide (Installing Oracle Email Server 
section). Oracle Email Server was formerly known as Oracle Internet Messaging 
(IM).

In the post-install Email Server configuration, select NO for LDAP install. For 
more information on this step, refer to the Oracle Email Server Installation Guide 
(Configuring Oracle Email Server section).

Once the installation process is complete, you can configure the Oracle Email 
Server instance to talk with the Oracle Applications Instance.

2. Connect to the Oracle Email Server database instance with the OO user and 
password. Grant privilege on IM_IMT_EXTN to oraoffice.

3. Create a sqlnet tnsnames entry on the Oracle Email Server machine to point to 
the Oracle Applications Instance. (If installed on an instance separate from 
Oracle Applications Instance).

4. Create a Database Link to the CRM instance from the Oracle Email Server 
instance. You need the following:

■  Password for the Oracle Applications APPS schema.

■  Password for the Oracle Email Server OO schema.

Use SQLPLUS to login to Oracle Email Server as user OO (using the OO 
password entered during Oracle Email Server installation) and use the 
following to create the database link:

CREATE DATABASE LINK <link name> CONNECT TO <APPS 
username> IDENTIFIED BY <APPS password> USING <tns / service 
name>;

Note: The default configuration is single instance. Single instance 
implies that Oracle Applications data and Oracle Email Server data 
reside in the same database.
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Installing and Configuring Oracle eMail Center Server (eMC)
Use this procedure to install and configure Oracle eMail Center Server (eMC 
Server).

Overview
eMC Server is installed as part of the Call Center Applications installation process.

Prerequisites
Before you can create an eMC Server, you must create a Server Group for the eMC 
Server.

Perform the following steps to create a server group:

1. Open the Server Administration module from the Front Office Navigator, 
the Call Center Administration module, or the Routing Server 
Administration module.

The Server Locator Window opens at the Server Group tab screen.

2. In the Server Group Registration area, enter the server Group Name, 
Location, and Description.

3. From the File menu, choose Save.

Steps
1. From the Self Service application login screen, login using the default system 

administrator user name and password.

Note: The name of the above mentioned database link <link 
name> is used later to configure other eMC components.

Note: Oracle eMail Center follows the Oracle standard for User 
Interfaces and the following field colors indicate:

Yellow - required field

White - optional field

Grey - read only field

Light blue - query mode
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2. From the list of application responsibilities, select Call Center Server 
Administration.

The Call Center Server Administration module appears.

3. From the Call Center Server Administration module, double-click UWQ Server 
Locator (if it doesn’t open automatically).

The Server Locator screen appears.

4. From the Server Locator screen, click the Server tab.

5. In the Server Registration area, type data for the following fields:

■ Server Name

■ Server Location

■ Type Name - select iCenter Server from the drop-down list, click OK

■ Member Group Name - select the server group you want this server to 
belong to, click OK

■ Using Group Name - select the using group ID from the drop-down list, 
click OK This identifies other groups that have permission to use this 
server.

■ User Address - optional field, enter information if you wish

■ Description - optional field, enter information if you wish

■ Server Parameter - not required for configuring eMC Server

■ Value - not required for configuring eMC Server

6. From the File menu, click Save.

References
For detailed information on installing eMC Server, please refer to the Oracle Call 
Center Applications Setup documentation.

Refer to the Oracle Telephony Manager Concepts and Procedures documentation for 
detailed information on creating a server group.

Note: DNS Name and IP Address will be automatically assigned 
after the eMC Server is run for the first time.
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Implementation
This topic provides a high level overview of the implementation process. This 
section is designed to furnish you with an overall idea of the order in which the 
implementation of Oracle eMail Center occurs. Each of the steps will be expanded 
upon in individual topics.

Prerequisites
The installation process must be completed before you can begin implementing 
eMail Center.

High-level Steps
1. Create Email Accounts on the Email Server

2. Create User Accounts

3. Define Email Server Accounts

4. Create an eMail Center Agent

5. Set up Routing for Inbound Email

6. Configure eMail Center Properties

7. Configure UWQ to Launch the Business Application

8. Create Classifications and Themes

9. Configure Inbound Email Templates

10. Configure Outbound Email Response Templates and Queries

11. Upload Suggested Response Documents

12. Use Email Processing Workflow

Creating Email Accounts on the Email Server
For detailed information about creating email accounts on the Email Server, refer to 
the Managing Directory Information chapter of the Oracle Email Server 
Administration documentation (Creating Email Server User Accounts section).
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Creating User Accounts
Oracle eMail Center System Administrator Interface ships with four default 
responsibilities, eMail Center Administrator, eMail Center Operations Manager, 
eMail Center DBA, and eMail Center Client. The process of setting up an 
Administrator or Operations Manager and assigning the appropriate 
responsibilities consists of several steps.

1. Creating an employee (forms app)

2. Creating a user (HTML app)

3. Assigning user responsibilities (forms app)

4. Setting JTF default profiles (forms app)

5. Setting UWQ Profiles (forms app)

6. Setting CRM resources (forms app)

t You need to assign JTF_ADMIN role
tt You cannot perform this step until the OES accounts are defined in eMail 
Center

Note: You should have administrator level access to both the 
forms and the HTML based applications to perform these tasks.

Step: 1 2 3 4 5 6

Admin X X X X

Ops. Manager X Xt X X X

DBA X X X

Agent X X X X X Xtt
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Creating an Employee With Oracle HRMS
Use this procedure to create employees with the Oracle Human Resources 
Management System.

Prerequisites
To perform the following steps, you must have Oracle HRMS installed and 
configured.

Steps
1. From the common CRM login screen, type the default system administrator 

user name and password.

The CRM default screen appears.

2. Click the User tab.

3. Click the Add sub-tab.

The User Registration screen appears.

4. On the User Registration screen, enter data for all required fields.

■ Select "End User" from the Account Type drop-down list

5. Click Submit.

Note: You cannot create the agent account at this time. You must 
first define the email server accounts as shown in the Defining 
Email Server Accounts topic. Once you have defined the email 
server accounts, you can then create the agent accounts by 
following steps 1-6 above.

Note: If you do not have Oracle Human Resources Management 
System installed, you will need to create the employee using the 
Oracle Resource Manager application.

Note: If the employee already exists, you do not need to perform 
this step.
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6. Click the Assign Roles sub-tab.

The Search User screen appears.

7. On the Search User screen, type the user name and click Go!.

The User Name table appears.

8. From the list of names, click the desired user name.

The User - Role Mapping table appears

9. Select the JTF_FM_ADMIN role (this role allows integration with the 
Fulfillment console).

10. Click ">" to assign the above role to the user.

11. Click Update.

Creating a CRM User
Use this procedure to create CRM users.

Steps
1. From the common CRM login screen, type the default system administrator 

user name and password.

The CRM default screen appears.

2. Click the User tab.

3. Click the Add sub-tab.

The User Registration screen appears.

Note: Perform the following steps for creating the Operations 
Manager account ONLY.

Note: You can search all user names by performing a wildcard 
search instead of typing the full user name.

Note: Do not exit the application once you select roles!
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4. On the User Registration screen, enter data for all required fields.

■ Select "End User" from the Account Type drop-down list

5. Click Submit.

6. Click the Assign Roles sub-tab.

The Search User screen appears.

7. On the Search User screen, type the user name and click Go!.

The User Name table appears.

8. From the list of names, click the desired user name.

The User - Role Mapping table appears

9. Select the JTF_FM_ADMIN role (this role allows integration with the 
Fulfillment console).

10. Click ">" to assign the above role to the user.

11. Click Update.

Assigning User Responsibilities
Use this procedure to link the user to the employee and to assign user 
responsibilities.

Note: Perform the following steps for creating the Operations 
Manager account ONLY.

Note: You can search all user names by performing a wildcard 
search instead of typing the full user name.

Note: Do not exit the application once you select roles!
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Steps
1. From the Self Service application login screen, login using the default system 

administrator user name and password.

2. From the list of application responsibilities, select the System Administrator 
responsibility.

The Navigator System Administrator screen appears, displaying a list of 
functions.

3. From the list of functions, click Security, User, then Define.

The User form appears.

4. Query each type of user and assign the appropriate responsibility to that user.

5. From the drop-down list in the Person field, select the name of the 
corresponding employee previously created in the Creating an Employee section.

Note: If you are already logged into the Oracle Forms application, 
click File, select Switch Responsibility, and select System 
Administrator. Otherwise, follow steps 1 and 2.

User Type Responsibility

Administrator eMail Center Administrator

Operations Manager eMail Center Operations Manager

DBA eMail Center DBA

Agent eMail Center Client (agent interface)

Note: If you want the agent to be able to handle telephone calls, 
then select Interaction Center Agent as the responsibility.

Note: You can search all user names by performing a wildcard 
search instead of typing the full user name.
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6. From the File menu, click Save.

References
For more information on setting up the UWQ Selector and selecting agent work, 
refer to the Oracle Universal Work Queue Concepts and Procedures and UWQ Selector 
GUI documentation.

For more information on creating users, refer to the Oracle Human Resources 
Management System (HRMS) documentation.

Setting JTF Default Profiles
Use this procedure to set JTF default profiles.

Prerequisites 
You must know the responsibility ID for eMail Center Administrator, Operations 
Manager and Agent before setting the JTF profile. To find the responsibility ID, 
perform the following steps:

1. From the Navigator System Administrator screen, click Security, 
Responsibility, then Define.

2. Query the desired responsibility based on the table below:

3. From the Help menu, click Diagnostics, then Examine....

The Examine Field and Variable Values screen appears.

4. Click the drop-down list in Field.

Note: Oracle recommends that only one user is assigned to each 
employee. It is possible, however, to assign multiple user IDs to an 
employee, even though you will receive warning messages.

User Type Responsibility

Administrator eMail Center Administrator

Operations Manager eMail Center Operations Manager

Agent eMail Center Client (agent interface)
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The Choose a Field screen appears.

5. From the list in the Choose a Field screen, select the RESPONSIBILITY_ID.

6. Click OK.

The value of the RESPONSIBILITY_ID is displayed in the Value Field of the 
Examine Field and Variable Value screen.

7. Click OK.

Steps
1. From the Navigator System Administrator screen, click Profile, then System.

The Find System Profile Values screen appears.

2. From the Find System Profile Values screen, click Clear.

3. Click the User check box and from the drop-down list in the User field, select 
the user name.

4. In the Profile field, type %JTF_PROFILE_DEFAULT% and click Find.

A list of system profile values appears.

5. In the User column, set the following values for these profiles:

Note: Repeat these steps for the Administrator, Operations 
Manager, and Client responsibilities.

Profile Value Description

JTF_PROFILE_DEFAULT_
APPLICATION

680 eMail Center value for the 
application ID.

JTF_PROFILE_DEFAULT_
LANG

US This is the language code. (It is 
possible that you may not have this 
profile. If this is the case, your 
language setting is controlled by the 
ICX: Language profile).

JTF_PROFILE_DEFAULT_
NUM_ROLES

15

(recommended)

This determines the number of 
rows you can see on each page 
when in browse mode.

JTF_PROFILE_DEFAULT_
RESPONSIBILITY

This is the value responsibility ID 
you obtained in the prerequisite 
steps.
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6. From the File menu, click Save.

7. Repeat these steps for every user with the Administrator or Operations 
Manager responsibility.

Setting UWQ Profiles
Setting the following UWQ profiles controls the kind of work (telephone calls, 
email, etc.) that is queued for an agent.

UWQ profiles only need to be set for agent accounts. Use this procedure to set 
UWQ profiles.

Steps
1. From the Profile screen, type%IEU% in the Find field (this will search all 

profiles that start with IEU).

2. Click OK.

A list of profiles appears.

3. From the list of profiles, select IEU: Queue: Inbound Email.

4. Click OK.

The Inbound Email Profile appears in the System Profile Values screen.

5. From the drop-down list in the User field, select YES.

6. Save the record.

7. Repeat steps3 through 6, selecting profiles for IEU: Queue: Email and IEU: 
Blending Style.

8. Save the record to complete the process of setting up UWQ profiles for the new 
agent.

Note: The profile must be selected for the site level before 
selecting it for the agent level.

Note: For the IEU: Blending Style profile, select Not Blended 
from the drop-down list in the User field.
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Setting CRM Resources
These steps should only be performed to set CRM Resources for users with the 
Operations Manager and Agent responsibility.

Use this procedure to set the CRM resources.

Steps
1. From the Navigator System Administrator screen, click File, then Switch 

Responsibility.

2. Select the CRM Administrator responsibility.

A screen appears, displaying a list of functions.

3. From the list of functions, double-click the Resources Manager.

4. Double-click Maintain Resources.

5. Double-click Import Resources.

The Selection Criteria screen appears.

6. From the Resource Category field, select Employee.

7. From the Name field, select the new employee’s name.

8. Click Search.

The Search Results list appears, displaying a row of data with Category set to 
Employee and Name set to the new employee’s name.

9. Click Create Resource.

The Default Values screen appears.

10. Click OK.

The Selected Resource screen appears.

11. From the Selected Resources screen, click Save Resource.

12. Click Detail.

The Resource screen appears.

13. Perform the following steps depending on the account type:

For Operations Manager account(s):
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■ In the Roles tab, select Marketing Encyclopedia from the drop-down list 
for Role Type and select MES Administrator from the drop-down list for 
Roles (this allows integration with the MES application).

For Agent account(s)

■ In the Interaction Center tab, select the desired interaction center you wish 
to associate with the eMail Center from the drop-down list in the 
Interaction Center field. From the drop-down list in the Email Account 
field, select the desired email account. Select Default from the drop-down 
list for the Parameter field and click the Value field to select the default 
values.

14. Accept the default values on the remaining tabs.

15. From the File menu, click Save to save the resource.

Defining Email Server Accounts
This topic group provides a high-level overview of the steps necessary to define 
Email Server accounts in the eMail Center System Administrator Interface, a 
worksheet for gathering all the necessary information, and detailed steps for 
performing each part of the defining Email Server accounts procedure.

High-level Steps

Prerequisites
To perform the following steps, you must have an administrator level status.

High-level Steps
1. Create a Server Group entry.

2. Define an eMC Server entry and assign the eMC Server entry to the previously 
created Server Group.

3. Define an Email Db entry and assign this Email Db entry to the previously 
created Server Group.

Note: The eMail Center System Administrator Interface is an 
HTML based console and is separate from the Oracle Applications 
forms based Admin console.
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4. Define one database link and create two others. You will define the link from 
OES to the Apps instance created earlier, and you will create two links to your 
Email Db (your Oracle Email Server database). One link for user <oraoffice> 
(synchronize accounts) and one for user <OO> (mail manipulator accounts). In 
a single instance scenario, the database link would be self-referencing.

5. Define an Email Server entry and assign this Email Server to the previously 
created Server Group.

6. Enable the two queues (if they are not already enabled).

7. Create an account for every user.

References
For more information on defining Email Server accounts, refer to the following 
documentation:

Oracle eMail Center Concepts and Procedures

Oracle Email Server Administration Guide

Oracle Universal Work Queue Concepts and Procedures

Defining Email Accounts Worksheet
Use the following worksheet to gather all the necessary information for completing 
the detailed tasks in the Defining Email accounts procedure.

Note: You can choose to run your IMAP/POP and SMTP 
processes on the same machine as the Oracle Email Server or on a 
different machine. For detailed information, refer to the Oracle 
Email Server Administration Guide.

Note: For detailed information on creating entries in the 
Interaction Center drop-down list, refer to the Oracle Universal Work 
Queue (UWQ) documentation.
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Create Server Group

Create EMC Server

Create Email Database Server

Create Database Link

Create Email Server

Group Name:_________________________ Group Description:___________________________

EMC Server Name:____________________ IP Address:__________________________________

DNS Name:___________________________ Group Server:________________________________

Database Name:_______________________ Service Name:________________________________

Host Name:___________________________ Database Description:_________________________

Port:_________________________________ RT Availability:_______________________________

Protocol:_____________________________ Group Server:________________________________

Database SID:_________________________

Server:_______________________________ User:_________________________________________

Name:_______________________________ Password:____________________________________

Email Server Name:____________________ RT Availability:______________________________

DNS Name:___________________________ Group Server:________________________________

IP Address:___________________________ Server Type:_________________________________

Port:_________________________________
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Create Account

Define Server Group
Use this procedure to define the server group.

Steps
1. From the common CRM login screen (HTML), type the default system 

administrator user name and password.

The eMail Center System Administrator Interface appears, displaying the 
Server tab screen.

2. From the Server tab screen, click the Group sub-tab.

The Server Groups screen appears.

3. From the Server Groups screen, click Create.

The Create Group screen appears.

4. Type a group name and a group description in the provided fields.

5. Click Create to save the record.

The server group is created and you return to the Server Groups screen.

Define eMC Server
Use this procedure to define the EMC Server.

Steps
1. From the Server Groups screen, click the EMC sub-tab.

The EMC Servers screen appears.

Name:________________________________ Email Server:__________________________________

Domain:______________________________ Interaction Center:______________________________

Profile:_______________________________

Note: If you do not see your new server group displayed, use the 
Next and Last commands to locate it in the list.
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2. From the EMC Servers screen, click Create.

The Create EMC Servers screen appears.

3. Type the EMC server name, DNS name, and IP address in the provided fields.

4. From the drop down list in the Group Server field, select the server group you 
previously created.

5. Click Create to save the record.

The EMC server is created and you return to the EMC Servers screen.

Define Email Database Server
Use this procedure to create the email database server.

Steps
1. From the EMC Servers screen, click the Email DB sub-tab.

The Database Servers screen appears.

2. From the Database Servers screen, click Create.

The Create Database screen appears.

3. Type the database name, hostname, port, protocol, SID, service name, 
description, and RT availability in the provided fields.

4. From the drop down list in the Group Server field, select the server group you 
previously created.

5. Click Create to save the record.

The database server is created and you return to the Database Servers screen.

Create Database Links
Use this procedure to create database links.

Note: If you do not see your new EMC server displayed, use the 
Next and Last commands to locate it in the list.

Note: If you do not see your new database server displayed, use the 
Next and Last commands to locate it in the list.
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Steps

1. From the Database Servers screen, click the DB Link sub-tab.

The Database Links screen appears.

2. From the Database Links screen, click Create.

The Create Database Link screen appears.

3. From the drop-down list in the Server field, select the server.

4. Type the name, user and password in the provided fields.

5. Click Create to save the record.

The database link is created and you return to the Database Links screen.

Define Email Server
Use this procedure to define the email server.

Steps
1. From the Database Links screen, click the Email sub-tab.

The E-mail Servers screen appears.

2. From the E-mail Servers screen, click Create.

The Create E-mail Server screen appears.

Note: You will need to perform these steps three times. First for the 
<oraoffice> user and then for the <OO> user, then to define the link 
going from OES to Apps that you created earlier.

Note: If you do not see your new DB LinkName displayed, use the 
Next and Last commands to locate it in the list.

Note: You need to perform these steps twice. Once to define the 
IMAP server and once to define the SMTP server. IMAP is the 
protocol for the agent interface to talk to the server and SMTP is the 
protocol for communications across the internet.
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3. Type the email server name, DNS name, IP address, port, and RT availability in 
the provided fields.

4. From the drop down list in the Group Server field, select the server group you 
previously created.

5. From the drop-down list in the E-Mail Server Type field, select the email server 
type.

6. Click Create to save the record.

The email server is created and you return to the E-mail Servers screen.

Enable Queues
Use this procedure to enable the queues.

Steps
1. From the E-Mail Servers screen, click the Queue tab.

The Advanced Queues screen appears.

2. From the Select column, click the check box for the two desired queues.

3. Click Enable to enable the two selected queues.

4. Once you have enabled the queues, click Refresh.

The Advanced Queues screen updates to reflect the new status for the selected 
queues.

Create Account
Follow the steps below to create the accounts you wish to have on your site 
(example: Classifications, or Support).

Note: If you do not see your new email server name displayed, use 
the Next and Last commands to locate it in the list.
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Steps
1. From the Advanced Queues screen, click the Account tab.

The Accounts screen appears, displaying information in table form for all 
current accounts.

2. Click Create.

The Create Account screen appears.

3. Type the account information in the provided fields.

4. Once you have provided the required information, click Create to save the 
record.

You are returned to the accounts screen and your new account is displayed in 
the table.

5. Repeat steps 2 through 4 for each account you wish to receive email.

Creating an eMail Center Agent
Once you have created your accounts on the Email Server, you can create your 
eMail Center agent user accounts. To create an eMail Center agent user accounts, 
follow the procedures provided in the Creating User Accounts topic.

Setting up Routing for Inbound Email
Follow the steps in the following chart to set up rules-based routing. The chart 
shows you where to read in detail about the setup step. The Window Names(s) 
column shows you in which window(s) you perform the step, and if the window is 
available only if you use a specific responsibility or product. The Required column 
shows you if the step is required, optional, required with defaults, or conditionally 
required.

Note: You will need to perform these steps for every account you 
wish to receive email.

Note: To create an agent, you must first define the email server 
accounts.
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High Level Steps
1. Define a group.

2. Define a route.

3. Define the route priorities.

4. Define the classifications.

Defining Groups
There are two types or groups for rules-based routing: static and dynamic. A static 
group requires that you manually edit information about individual group 
members. In a dynamic group, the database automatically updates information 
about individual group members.

For procedures, see:

■ Defining a Static Group

■ Defining a Dynamic Group

Defining a Static Group
Use this procedure to configure a static group for routing.

Prerequisites
None

Steps
1. Navigate to the Define Groups window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Server Administration.

The Routing Administration window appears.

b. Click Static Groups.

The Define Groups window appears.

Guidelines
When configuring static groups, use the following guidelines:
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■ The Group Number and Group Name must be unique. 

■ If you want to prevent an agent from being shared with other groups, check the 
Exclusive Flag box to indicate that the agent belongs exclusively to this group.

■ You cannot create member records without choosing a Parent Group. 

■ When defining a static/dynamic group for Routing, the usage of the group 
should be set to ’Call Center’ so that the group will be available in the Routing 
Admin LOV for static/dynamic groups. 

Defining a Dynamic Group
Use this procedure to configure a dynamic group for routing.

Prerequisites
None

Steps
1. Navigate to the Dynamic Groups window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Server Administration.

The Routing Administration window appears.

b. Click Dynamic Groups.

The Dynamic Groups window appears.

2. If necessary, choose File > New.

3. Enter a unique name for the group.

4. From the Usage list, select the usage of the list.

5. Optionally, enter a description of the list.

6. Optionally, in the Active Dates area, select or enter the start and end date for the 
use of the group in routing.

7. Enter the SQL statement that selects the members of the group.

8. Click Check Syntax.

If the SQL statement is invalid, then an error message appears. If the SQL 
statement is valid, then no message appears.
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9. From the File menu, choose Save.

Guidelines
■ When defining a static/dynamic group for Routing, the usage of the group 

should be set to ’Call Center’ so that the group will be available in the Routing 
Admin LOV for static/dynamic groups. 

Defining Routes
A route definition identifies the potential groups or members to which a call may be 
routed and the call parameters (such as ANI) to be used in determining the 
destination of a call.

There are two types of routes for rules-based routing: static and dynamic. Static 
routing is based on data stored in cache. Dynamic routing is based on PL/SQL 
queries. Static routing is faster, but dynamic routing is more flexible. 

For procedures, see:

■ Defining a Static Route

■ Defining a Dynamic Route

Defining a Static Route
Use this procedure to define a static route.

Prerequisites
Define a group. For more information, see the Defining Groups topic.

Steps
1. Navigate to the Routing Administration window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Server Administration.

Note: If the route server cannot determine agents from the 
defined destinations, then the server routes the message to the 
default destination defined for the route.
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The Routing Administration window appears.

2. If necessary, choose File > New.

3. In the Route Definition area, identify the route.

a. Enter a unique name to describe the route.

b. From the Route Type list, select Static.

c. Optionally, enter the description of the static route.

d. If this route uses the Oracle Applications database, select Application 
Database.

e. If this route does not use the Oracle Applications database, select Non 
Application Database and enter the database driver and URL.

4. On the Route Destinations tab, select the groups to which calls may be routed.

5. On the Route Rules tab, define the parameters expected in an incoming call.

a. From the Key list, select a key (for example, ANI).

b. Enter the value for the selected key (for example, 888-555-1234).

6. From the File menu, choose Save.

Defining a Dynamic Route
Use this procedure to define a dynamic route.

Prerequisites
None

Steps
1. Navigate to the Routing Administration window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Server Administration.

The Routing Administration window appears.

2. If necessary, choose File > New.

3. In the Route Definition area, identify the route.

a. Enter a unique name to describe the route.
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b. From the Route Type list, select Dynamic.

c. From the Default Destination list, select the default destination to be use 
when the Routing Server cannot determine a destination based on the 
procedure parameters.

d. Enter the description of the dynamic route.

e. If this route uses the Oracle Applications database, select Application 
Database.

f. If this route does not use the Oracle Applications database, select Non 
Application Database and enter the database driver and URL.

4. On the Route Destinations tab, define the procedure that is to be used to derive 
the destination for call.

a. In the Dynamic Destination area, enter the name of the procedure 
(Package.Procedure) that is to be used to derive the destination for message.

b. In the Procedure Parameters area, identify the parameters for the 
procedure.

Sequence is a generated number that indicates the sequence of the 
parameter.

5. On the Route Rules tab, define the rules for the route.

a. From the Key list, select a key (for example, ANI).

b. Enter the value for the selected key.

6. From the File menu, choose Save.

Defining Route Priorities
You can define and change the priority of route definitions. Changing the value of a 
route priority affects the values of other route priorities. If you increase the value of 
a priority, then the priorities of all the routes with a value equal to or greater than 
the original value decrease by one. If you decrease the value of a priority, then the 
value of all the routes with a value equal to or less than the original value increase 
by one. For example, if you decrease 6 to 3, then 3 increases to 4, 4 increases to 5, 
and so on. If you increase 3 to 6, then 4 decreases to 3, 3 decreases to 2, and so on.

Use this procedure to set the priority for a route.
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Prerequisites
None

Steps
1. Navigate to the Routing Priority window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Priority Administration.

The Routing Priority window appears.

2. From the Priority list, select a priority.

3. Click Change Priority.

4. From the File menu, choose Save.

Defining Classifications
Classifications specify how to identify and route particular types of messages that 
are associated with the selected Route ID. Classifications are of two types: literal 
and database procedure. A literal classification is a string. A database procedure 
classification is a stored procedure.

Classification rules can determine the route that a call must take, or a classification 
rule can designate a message as a classification for reports or for screen pops. Every 
classification must have rules that define the conditions under which the 
classification occurs. When a message meets all these conditions, the classification is 
the result and the message is routed accordingly.

A classification can have multiple rules associated with it. An individual route can 
have multiple destinations, which can be either static or dynamic. Every route has a 
sequence of a Key and a Value whose relationship is determined by one of the 
available Operations (=, !=, >, >=, <, <=).

If an incoming routing request results in a new classification, the new classification 
is added to the route request as one of the parameters. The server tries to find a new 
route based on this route request.
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For example, if the classification rules in the preceding table result in adding the 
new classification rule CLASSIFICATION=GOLD to the classification request, then 
a new route is determined based on the new rule.

For procedures, see:

■ Defining a Literal Classification

■ Defining a Database Procedure Classification

Defining a Literal Classification
Use this procedure to define a literal classification.

Prerequisites
None

Steps
1. Navigate to the Classification Administration window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Classification Administration.

The Classification Administration window appears.

2. If necessary, choose File > New.

3. In the Classification Definition area, define the classification.

a. Enter a unique name to describe the classification.

b. From the Type list, select Literal.

c. Enter the maximum amount of time, in seconds, that the Routing Server 
should spend trying to determine the destination.

d. If this classification uses the Oracle Applications database, select 
Application Database.

e. If this classification does not use the Oracle Applications database, select 
Non Application Database and enter the database driver and URL.

Note: If you configure a classification rule that results in a new 
rule, then you will need a route that is defined for that new rule.
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4. On the Classification Rules tab, define the rules for routing based on the keys 
identified in the route definition.

a. From the Key list, select a key.

b. From the Operation list, select an operator.

c. Enter the value for the selected key.

5. From the File menu, choose Save.

Defining a Database Procedure Classification
Classifications specify how to identify and route particular types of messages that 
are associated with the selected Route ID. A database procedure classification is a 
stored procedure. The following conditions apply.

Prerequisites
None

Steps
1. Navigate to the Classification Administration window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Classification Administration.

The Classification Administration window appears.

2. In the Classification Definition area, define the classification.

a. Enter the name of the database procedure.

b. From the Type list, select Database Procedure.

c. Enter the maximum amount of time, in seconds, that the Routing Server 
should spend trying to determine the destination.

Note: A key used in a classification rule must be the same as that 
identified in the route rules definition.

Note: The name of the classification is not verified against the 
stored procedures. Be sure to enter the correct procedure name.
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d. If this classification uses the Oracle Applications database, select 
Application Database.

e. If this classification does not use the Oracle Applications database, select 
Non Application Database and enter the database driver and URL.

3. On the Classification Rules tab, define the rules for routing based on the keys 
identified in the route definition.

a. From the Key list, select a key.

b. From the Operation list, select an operator.

c. Enter the value for the selected key.

4. On the Classification Parameters tab, identify the parameters for the database 
procedure.

a. From the Parameter list, select a parameter.

b. From the Datatype list, select the data type of the parameter (for example, 
VARCHAR).

c. From the Direction list, select the direction of the parameter (for example, 
IN).

Sequence is a generated number that indicates the sequence of the 
parameter.

5. From the File menu, choose Save.

Configuring eMail Center Properties
Use this procedure to configure the properties for eMail Center. This procedure 
provides the UWQ Server with the URL to launch the eMail Center agent interface 
component. This step is only required when setting up the system for first time use, 
or after changing the Apache server root.

Steps
1. From the common CRM login screen, type the default system administrator 

user name and password.

Note: A key used in a classification rule must be the same as that 
identified in the route rules definition.
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The CRM default screen appears.

2. From the default screen, click the Advanced tab.

The Advanced screen appears.

3. From the Advanced screen, click the Properties sub-tab.

4. From the View drop-down list on the Properties sub-tab, select IEM.

A list of links should appear.

5. From the list, click the link iem.base.url.

6. Type the Apache server system root URL in the Value field (e.g. 
http://www.visioncorp.com/)

7. Click Update.

You return to the previous screen.

8. Click Update again to save all changes.

References
For more information, refer to the Administering Oracle eMail Center section of the 
Oracle eMail Center Concepts and Procedures documentation.

Use this procedure to configure the properties for eMail Center. This procedure 
provides the UWQ Server with the URL to launch the eMail Center agent interface 
component. This step is only required when setting up the system for first time use, 
or after changing the Apache server root.

Steps
1. From the common CRM login screen, type the default system administrator 

user name and password.

Note: If the list of links does not appear after step 4, click Create 
and the Create Key screen appears. Type iem.base.url in the Key 
field and move on to step 6.

Note: You must include the last slash (/) in the URL, as it is 
required.
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The CRM default screen appears.

2. From the default screen, click the Advanced tab.

The Advanced screen appears.

3. From the Advanced screen, click the Properties sub-tab.

4. From the View drop-down list on the Properties sub-tab, select IEM.

A list of links should appear.

5. From the list, click the link iem.base.url.

6. Type the Apache server system root URL in the Value field (e.g. 
http://www.visioncorp.com/)

7. Click Update.

You return to the previous screen.

8. Click Update again to save all changes.

References
For more information, refer to the Administering Oracle eMail Center section of the 
Oracle eMail Center Concepts and Procedures documentation.

Configuring UWQ to Launch the Business Application
Follow the steps below to define the business application for Oracle Universal Work 
Queue to pop or start when emails are delivered to users.

Note: If the list of links does not appear after step 4, click Create 
and the Create Key screen appears. Type iem.base.url in the Key 
field and move on to step 6.

Note: You must include the last slash (/) in the URL, as it is 
required.
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Prerequisites
Any application that needs to be "popped" must be successfully installed, 
configured, and made available to UWQ. For more information on how to make a 
new application available to UWQ contact the UWQ Product Manager.

Steps
1. From the Self-Service (Forms) application, log in using an account that has 

access to the UWQ Administrator responsibility. 

2. Double click the UWQ Administrator responsibility.

The Media-Action-Classification-Association form appears.

3. Click the Media Type field and select the LOV.

4. Select a Media Type. (Example, Inbound Email).

5. Click the Classification field and type the classification for which you would 
like to associate the screen pop or Media Action.

6. Click the Media Action field and select the LOV.

7. Select Customer Care Media Function proc.

8. Repeat steps 5-9 to create additional Media Action Classification Associations.

Creating Classifications and Themes

Overview
Resolving interactions involves two major challenges:

■ Understanding the intent of the communication. What is being requested or 
communicated?

■ Determining the appropriate responses or actions necessary to resolve the 
interaction

These challenges can be answered by human intervention (an agent reads and 
responds), a semi-automated process that requires human assistance, or a fully 
automated analysis and response.

A fully automated process requires three processes:

■ Beginning: Analyze the intent of the unstructured email message

■ Middle: Classify the intent
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■ End: Suggest one or more responses to the message, based on the classification

Oracle eMail Center uses the iMT (interMedia Text) feature of the Oracle 8i database 
to analyze incoming email messages based on the linguistic properties of the 
various parts of the email, such as header, subject, and body. The term 
“classification” refers to the category under which the email should be classified. A 
good example of classifications for a hardware company would be Accessories, 
Service, Product Information, Installation, etc.

Each classification has a set of underlying theme signatures that are used by iMT to 
classify the email. Each theme signature for a classification has an associated score, 
which is used to order the classifications base on probability percentage.

This weighting methodology applies to theme signatures for responses as well. 
After a message is classified, eMail Center creates a search string based on the 
combination of the incoming message theme set and the response theme set. This 
search string is then used to query the MES database to retrieve the suggested 
response documents.

Classifications and themes can be created in two ways:

■ By sending email to a “classification” email account

■ From the eMail Center Operations Manager console

Terms
Classification - the intent(s) of an email message.

Classification (as eMC sees it) - categories into which incoming email messages are 
sorted.

Classification Theme Signature - collection of themes and associated weights for 
the specified classification.

Note: Please note the distinction between eMC classifications and 
the classifications derived by the routing server.

■ eMC classifications indicate the intent of a message.

■ Routing classifications are used in the UWQ GUI to display 
media items and may or may not relate to the intent of a 
message.

■ Routing classification can be the account name into which the 
email arrived.
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Response Selection Theme Signature - collection of themes and associated weights 
for responses to a specified classification.

Sample Message - a cleaned up message or piece of text whose contents are directly 
related to the characteristics of the classification.

Sample Response - cleaned up response or piece of text whose contents are directly 
related to the characteristics of responses for the classification.

Theme - keywords or phrases extracted from the text of the message or relative 
terms selected from the knowledge base.

Theme Signature - collection of themes and their associated weights.

Weight - signifies the relative importance of a particular word in a given theme.

Creating Classifications and Themes by Sending Email
Use this procedure to create classifications by sending email to the "classification" 
email account.

Prerequisites
A “classification” email account should be created on the Email Server and should 
also be defined in the eMail Center.

Steps
1. Send an email to the “classification” account you created with the subject line 

reading:

<Classification Name><accountname@domainname><Q> OR

<Classification Name><accountname@domainname><R>

The letters ‘Q’ and ‘R’ above indicate whether the classification and corresponding 
theme signatures generated are for the incoming message (Q) or the outgoing 
response (R).

For example, if you created an email account called “support” for handling all 
support related issues and if you want to create a classification called “hardware” to 
categorize all hardware support issues, the email would have the following the 
subject line.

<hardware><><Q> OR <hardware><><R>
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Based on whether you append the letter ‘Q’ or the letter ‘R ‘ to the subject line, the 
iMT will treat the email body as a sample inbound message or a sample response 
and generate themes with associated weights for the same.

References
For detailed information on creating email accounts on the Email Server, refer to the 
Managing Directory Information chapter of the Oracle Email Server Administration 
documentation (Creating Email Server User Accounts section).

For detailed information on defining Email Server Accounts in the eMail Center, 
refer to the Defining Email Server Accounts section of the Oracle Email Server 
Administration documentation.

Creating Classifications from the Operations Manager Interface
Use this procedure to create classifications from the eMail Center Operations 
Manager Interface.

Steps
1. From the Oracle Applications Operations Manager screen, click the 

Classification tab.

The Classification screen appears.

2. From the Classifications screen, click Create.

The Create Classification screen appears.

3. In the Classification Name field, type the classification name.

4. From the drop down list in the Email Account field, select the email account.

5. Click Create.

The classification is created and you return to the Classifications screen.

Note: If the classification name specified in the subject line 
already exists, then the theme’s signatures (and their weights) will 
be updated for the existing classification based on the content of the 
email.
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Creating Themes from the Operations Manager Interface
Use this procedure to create themes from the eMail Center Operations Manager 
Interface.

Prerequisites
The classification for which you are creating a theme must already be created.

Steps
1. From the Oracle Applications Operations Manager screen, click the 

Classification tab.

The Classification screen appears.

2. From the Classifications screen, click the Themes sub-tab.

A drop down list appears, displaying all of the existing classifications.

3. From the drop down list, select the classification for which you wish to create 
themes.

4. Click Create.

The Create Themes screen appears, displaying the selected classification name.

5. In the provided fields, type the name and score for the theme you are creating.

6. From the drop-down list in the Type field, select the type of theme.

7. Click Create.

The new theme is created for the selected classification and you return to the 
Classifications screen.

Configuring Structured Email Templates

Overview
eMail Center includes a set of structured email templates (web forms). Structured 
email templates are HTML documents placed on an enterprise’s web server that can 
be filled out by a customer/prospect and result in the creation of a structured email 
when that customer/prospect clicks the Submit button. These templates can be 
used to leverage email as a tool to perform such tasks as create a service request, 
inquire about the status of service request, etc.
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You can enable the included templates to submit email by pointing the HTML code 
for the templates to the correct web server and configuring the web server to handle 
the EmailGeneratingServlet. To do so, perform the tasks in the Modifying Existing 
Templates topic group below.

If the included templates are insufficient for your purposes, you can create your 
own custom templates. To do so, perform the tasks in the Creating Inbound Email 
Templates topic group.

Modifying Existing Inbound Email Templates
This topic group provides steps for modifying the templates included with eMail 
Center, including:

■ Pointing the HTML Code to the Correct Web Server

■ Configuring the Web Server to Handle the EmailGeneratingServlet

Pointing the HTML Code to the Correct Web Server
Use this procedure to point the HTML code for the templates to the correct web 
server.

Steps
1. Modify the following line of HTML code to point to the correct server:

action="XXX/oracle.apps.iem.emailgen.EmailGeneratingServlet"

(Where XXX is the full path of the folder where the servlets are stored on the 
web server. This path should include the machine name, port information and 
the folder information.

For example: http://ap040sun.us.oracle.com:8000/jsp/

Configuring the Web Server to Handle the EmailGeneratingServlet
Use this procedure to configure the web server to handle the 
EmailGeneratingServlet.

Prerequisites
Before performing this task, your web server must be installed and configured to 
run JServ or its equivalent.
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Steps
1. Add the following line in the zone.properties file of JServ:

servlet.oracle.apps.iem.emailgen.EmailGeneratingServlet.initArgs=hostname
=<HOSTNAME>,to=EMAIL@DOMAIN

Creating Structured Email Templates
Templates are the structured email means by which customers can contact your 
interaction center. They are designed to provide information to eMail Center in a 
particular format that allows eMail Center to determine how to process the form. 
Forms are created as either User Interface forms or HTML forms, and are created 
using virtually any HTML authoring application. Templates are created using any 
text authoring application.

Allowed HTML Form elements include:

■ Buttons

■ Check boxes

■ Radio Buttons

■ Menus

■ Text Input

■ Hidden Controls

Each form will present a different predefined structured email template; however, 
there must be a structured email ID tag hidden on each form. The look and feel of 
the page can be customized to suit your needs.

Before creating UI forms, you should first determine two things:

■ What is the purpose of the form?

Note: HOSTNAME refers to the name of the machine on which 
the SMTP server is running. EMAIL refers to the email account and 
DOMAIN refers to the domain on which the email resides.

Note: Applets, image files and Active X controls should not be 
part of the form.



Creating Structured Email Templates

Implementing Oracle eMail Center 101

Every organization (and often project) is different, having different needs when 
it comes to capturing and managing information.

The purpose of the web form could be one of the several things. For instance, to 
check the customer’s order status or it could be a service request. Based on the 
purpose, the content of the form would change. For example, if the organization 
is a service oriented organization, the forms would contain fields that would 
capture the type of service requested by the user, and all the other associated 
information. If the organization were to be selling products, the forms would be 
populated with their product details and the user would be requested to select 
the various available products, quantity required, type of product requested etc.

■ What data must be captured to support processing?

The required data fields of the form are totally dependent on the calling 
applications data requirements.

Consider a service related situation. Capturing the customer account number or 
service request number or a product serial number would be vitally important. 
Capturing other useful information would be extremely helpful, but the ones 
that are mentioned above would be an absolute must, to ensure that the request 
is attended to by the eMail Center.

In a sales situation, capturing the customer’s contact information and perhaps, 
what products they are interested in would help to route it through the 
concerned department and give a response back to the customer.

In the case of general service information, it is possible to have a new customer, 
in which case, their contact information, their questions, concerns etc., would 
have to be obtained.

High-level Steps
The following steps assume you are using a HTML authoring application for 
creating inbound email templates:

1. Creating the title of the HTML form (template)

2. Creating the form tag

3. Create the hidden tag.

4. Adding form elements.

5. Adding validation logic.
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Steps
1. Create the title of your HTML form (template).

Example for a service request form:

<H2><font color=red><u> Got a Problem?</u></font></H2>

<H3>Use this handy form to submit a service request.</h3>

 <p>*<b>Required Fields</b>

<br><b></b>&nbsp;

2. Create the form tag.

In this example the form has the name submit_problem. The form tag should have 
an action and a method. The action refers to the Servlet to which the information 
from this form is submitted. The method is a post referring to the HTTP protocol 
used to transfer the information from this form to the Server. OnSubmit performs 
error checking to ensure that all the required fields are entered and in order.

<form name="submit_problem" 
action="http://servername.yourcompany.com/servlets/oracle.apps.iem.emailg
en.EmailGeneratingServlet" method= "post" onSubmit="return 
verifyfields(this)">

</Form>

3. Create your hidden tag. A hidden tag with the following value format must be 
part of each form (without this tag, the Servlet would not be able to process the 
request):

<EMAILTYPE>_<TYPE>_<SUBTYPE>

Example:

Tag Value

EMAILTYPE Used to indicate web-based or text. If an email is generated 
from web-based email client, EMAILTYPE will be "WEB". 
Otherwise its value will be "TXT".

TYPE Denotes the request group, such as ORDER REQUEST or 
SERVICE.

SUBTYPE Represents detail information about a request, such as CREATE 
or STATUS.
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<input type="hidden" name ="tag" value = "WEB_SERVICE_CREATE">

Having created the form tag and hidden tag, follow the steps below to add form 
elements.

4. Create a table to format the other form elements in order.

<table width = 100%>

5. Add the text input field to capture the email address.

<td><blockquote><div align=right><b>Email 
Address<b></div></blockquote></td>

<td>*<input type="text" name="emailadd" value="" 
size=20></td><td>&nbsp;</td>

The first column <TD> holds the label of the form element and the second column 
holds the input box where the user can enter the information. Most of the other 
fields in this form are also text fields and the syntax for those are given in step 6.

6. Add the remaining fields.

<td><blockquote><div align=right><b>Your 
Name<b></div></blockquote></td>

<td>*First Name</font>

<br><input type="Text" name="firstname" value="" size="20" 
maxlength="20"></td>

<td><div align=left>*Last Name

<br><input type="Text" name="lastname" value="" size="20" 
maxlength="20"></div>

7. Add the Submit and Reset buttons.

<td colspan=3><center><input type=Submit 
value=Submit>&nbsp;&nbsp;<input type=reset value=Reset> 

8. Close the table with a </table> tag.

Follow the steps below to add validation logic.

9. Add JavaScript Error Checking Code.

Ideally, you should place the JAVASCRIPT code within the head tags, but it can 
also be placed anywhere within the page.

10. Validate your form.
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Uploading Structured Email Templates in iSupport
The steps below assume that the customer has also purchased the Oracle iSupport 
application, through which the end-user will be able to submit an email via an 
inbound template. If you do not purchase the iSupport application, then you will 
need to open Windows Explorer and copy the structured email templates to the 
$IEM_TOP / html directory for your web server.

Use this procedure to upload structured email templates into iSupport.

Prerequisites
Before performing this task, iSupport must be installed and you must have an 
administrator level login.

Steps
1. Login to Oracle iSupport as an administrator.

2. From the iSupport default screen, click the Email Templates tab.

3. From the Email Templates tab, click Add Email Template.

4. In the Template Name field, type the name of the template.

5. In the Template Location field, type the location of the template.

Note: Error checking for required fields is mandatory to ensure 
that a proper automated response is sent back to the customer. The 
nature of error checking would depend on the type of form that is 
being submitted.

Note: Since the templates (HTML files) are referenced and not 
physically stored in the application, the administrator should be 
aware of the exact location of these files on the web server. 

Note: Use a name that best describes the template.
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6. Click Create.

References
For more information on uploading inbound templates to iSupport, refer to the 
Oracle iSupport documentation.

Verifying The Template is Referenced Correctly
Use this procedure to verify that you have referenced the template correctly in 
iSupport.

Steps
1. Login to Oracle iSupport as an administrator.

2. From the iSupport default screen, click Email.

3. Select the template you wish to verify by clicking the corresponding check box.

4. Click Continue.

The application should now be able to successfully display the contents of the 
template.

References
For more information on verifying the contents of the template in iSupport, refer to 
the Oracle iSupport documentation.

Note: Be sure to enter the full path (including the file name) for 
the location.

Important: You can update the location of a previously loaded 
template, but you cannot update the name. To update the name of 
the template, you must first remove the existing template and 
upload the template again with a new name.
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Configuring Automated Response Documents and Associated Queries

Overview
Automated responses to structured and unstructured inbound requests are handled 
by Oracle Fulfillment. Oracle Fulfillment is one of the CRM foundation products 
and should already be installed. The response documents in Fulfillment are referred 
to as “Master Documents”, and they may or may not have a query associated with 
them. If the master document has one or more merge fields, then it should have an 
associated query to populate those merge fields. The number of columns in the 
select clause of the query should equal the number of merge fields in the master 
document.

This topic group contains the tasks necessary to create and configure outbound 
email response templates, including:

■ Creating automated response documents

■ Creating the associated query

■ Uploading the automated response document and its associated query

Creating Automated Response Documents
You can create email forms and apply a query to generate a personalized outbound 
email. Automated response documents are created using any HTML editor. As 
stated earlier, prior knowledge of HTML is assumed here. Before creating an email 
template, you must identify the query containing the desired result set for the 
document. Release 11i of eMail Center will only support one query per email 
template; however, multiple email templates can use a single query.

The only dynamic content that eMail Center allows is the use of Merge fields and 
fragments. Merge fields were explained in the previous section. Fragments are zip 
files, which are stored in the MES tables.

The directory structure of the zip file must be organized in the following manner: 
place all HTML files and an images directory in the root. Place all associated images 
in the images directory.

Rules for Using Merge Fields and Fragments
A set of rules governs the use of both merge fields and fragments. The guidelines 
for using the merge fields and fragments are mentioned below.
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1. HTML documents can be created following HTML standards. These documents 
should be in directory. That directory’s structure should be a parent directory in 
which all the HTML files would reside, and an images directory in which all the 
associated images would be placed. The HTML files and an images directory 
with all the images associated with the HTML files would be zipped together 
and be available as a zip file. Release 11i 1-to-1 fulfillment will only support 
static images. This means images cannot be included in a HTML file as a merge 
field or as Fragments. Any image included in the HTML document needs to be 
in the images directory and the path of the image should point to the images 
directory.   For instance, in the response to Please Call Me form, a reference to 
the oracle logo would be like:

<img src="images/oraclelogo.gif"> 
�

2.  The list of available Merge Fields from the query will be in the file merge_
fields.txt (or any other name that you gave) that you previously created using 
the create data source button. (As explained in the previous section- Getting 
bind variables for a Query).

3. Bind variable names are case sensitive. When bind variables are used, they 
should be used exactly as they are referred to in the file that was created earlier. 
Cutting and pasting the bind names from the file merge_fields.txt would solve 
the problem.

Rules for Creating Automated Response Documents
1. Merge fields must be surrounded by the following special tag and special 

characters.

The tag that should surround the merge field is:

<span style=’mso-field-code’>&#171;  &#187;</span>

Mergefield can be placed in the middle as shown in the following example:

<span style=’mso-field-code’>&#171;Mergefield&#187;</span>

The Mergefield place holder is highlighted. Bold letters indicates the special 
tags and special characters that enclose the merge field. The highlighted 
Mergefield is just a place holder. The actual Merge field should be placed there 
in the document.

Note: The HTML file and the images directory are in the same 
level. All associated images should reside in the images directory.
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�

2. If merge fields are embedded in an HTML table, the table can only have two 
rows. The first row must be the table header and the second row should hold 
the merge fields. In such an instance, the data must be repeated for the number 
of times the rows are returned by the query.

3. Fragments cannot contain merge fields inside them. Fragments are zip files 
containing HTML files and an image directory with all associated images 
placed under it. This directory structure must be maintained all the time.

4. The tags surrounding the fragments are:

<span style=’fragment-field-code’ >&#171; &#187;</span> 

The Fragment ID would go in the middle as shown in the following example:

<span style=’fragment-field-code’ >&#171;FragmentID&#187;</span> 

Create an Associated Query
Use this procedure to create a query in Fulfillment before associating it with a 
master document.

Prerequisites
Before performing this procedure, Oracle Fulfillment must already be installed.

Steps
1. From the common CRM Login screen, login as the Fulfillment administrator.

2. Click the Query tab.

3. Click Create.

4. In the “Create Query” screen, type in data for the following fields.

■ Query Name - this name should be unique.

■ Query Description - a brief description of the query.

■ Query String - this is the SQL statement for the query. The number of fields 
in the “Select” clause should equal the number of merge fields in the master 

Important: Merge Fields are case sensitive and should be referred 
to exactly the same as they were obtained from the query.
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document. Do NOT end the query with a “;” or “/”, the standard SQL 
syntax to execute the query.

■ Application Database - the database instance against which the query 
should be run.

■ Application User Name - the userid of the account that should be used to 
run the query.

■ Application Password - the password for the above userid.

5. Click Create.
�

Uploading Automated Response Documents and Associated Queries
Use this procedure to upload an automated response document in Oracle 
Fulfillment and associate a query (if required).

Prerequisites
Before performing this procedure, Oracle Fulfillment must already be installed.

Steps
1. Login to the CRM application as a fulfillment administrator.

2. Click the Template tab.

3. Click the Master Document sub-tab.

4. Click Upload.

5. Type the full path for the filename, or click Browse to browse through your 
local file system.

6. After selecting the file click Upload.

A screen appears that alloys you to associate a query if required.

7.  In the Description field, type a brief description about the document.

8. From the Query drop-down list select the associated query name. If you don’t 
wish to associate any query select No Query which is also the default option.

Important: Once you create the query, please note the Query ID 
number. You will need this ID number for the verification process.
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9. Click Upload to complete the process of uploading a master document and 
associating a query to it.

Uploading Suggested Response Documents

Overview
Oracle eMail Center (eMC) uses the Marketing Encyclopedia System (MES) as its 
document repository. This topic group describes the process of uploading response 
documents into the response document repository (also referred to as KB or the 
knowledge base). MES stores documents under different categories. 

eMail Center requires a category called “EMC Templates” to store the email 
templates. These templates are standard email responses that an agent may use to 
respond to an inquiry and should not be confused with the “inbound templates” or 
customer service web forms that are uploaded in iSupport. Currently, eMail Center 
ONLY searches the “EMC Templates” category for email templates and all available 
categories for suggested responses.
�

High-level steps
1. Create the category in MES (only performed once).

2. Define a hierarchy among categories (only performed once).

3. Create a suggested response document.

4. Upload the documents into MES.

5. Verify the document was uploaded.

6. Create and upload an associated query (only if the document has merge fields).

7. Associate the suggested response document and the query.

References
For more information on MES categories, refer to the Oracle Marketing Online and 
Oracle Marketing Encyclopedia System documentation.

Important: We are also assuming that the customer has purchased 
iSupport (for the purpose of uploading inbound email templates). If 
the customer has not purchased iSupport, they should be aware of 
steps that need to be performed to reference the standard set of 
templates provided by eMail Center on their web server.
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Creating a Category in MES
Use this procedure to create a category in MES for the response templates.

Prerequisites
You must have a valid administrator login account.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Administration sub-tab.

4. From the MES Administration sub-tab, click Category Manager.

The Category Manager screen appears.

5. In the provided fields, type the name of the new category and a description of 
it.

6. Click Update.

Oracle Marketing Online creates the new category.

Defining a Hierarchy Among the Categories
Use this procedure to define a hierarchy among categories by creating 
sub-categories.

Prerequisites
Before you can define a hierarchy among categories, you must first create the 
categories as shown in the Creating a Category in MES topic.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Administration sub-tab.

4. From the MES Administration sub-tab, click Hierarchy Manager.
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The Hierarchy Manager screen appears, displaying a list of child and parent 
categories.

5. From the list of child categories (on the right column), select the desired child 
category.

6. From the drop-down list in the Parent Name (left) column, select the 
corresponding parent category.

7. Click Update.

Oracle Marketing Online links the child category to the selected parent 
category.

Creating a Suggested Response Document
A suggested response document can be a Word or an HTML document that may or 
may not have merge fields. A merge field is a place holder, for a variable which gets 
automatically filled when a query associated with document is fired. The associated 
query is executed when a response document is selected. The merge fields need to 
be enclosed within special tags, “«”, which can be entered by holding down the 
“Alt” key and typing “0171” on the numeric keypad (with the Num Lock Turned 
off), and “»”, which can be entered by holding down the “Alt” key and typing 
“0187” on the numeric keypad (with the Num Lock Turned off). Example:

Dear «CP_FIRST_NAME» «CP_LAST_NAME»,

Thank you for your interest in «PRODUCT_NAME». This product will be 
released on «RELEASE_DATE».

Uploading Documents Into MES
Use this procedure to upload response documents into MES.

Prerequisites
Before you upload response documents into MES, you must first create a category.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Publish sub-tab.
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4. From the drop-down list in the Item Type field, select an item type.
�

5. In the provided fields, type a title, author name, and description.

6. From the drop-down list in the Content Type field, select a content type.
�

7. Leave the Content Creation Date and Effective Start Date fields blank.

8. From the drop-down list in the Duration field, select Permanent.

9. Select a priority for the document.

10. Do not click the Create distribution rules on publish check box.

11. Click Find.

The Find screen appears, displaying a list of the categories.

12.  From the list, select the corresponding category.

13. Click Upload.

14. Click Browse to browse through the file system.

15. From the file system, select the desired document.

16. Click Open.

The entire path for the selected document is now displayed under File Name.

17. Click Attach File.

The file uploads. Once the file has fully uploaded, the File Name is no longer 
displayed.

Note: For response documents, you should select the item type 
File.

Note: For response documents, you should select the content type 
Master Document.

Note: You can expand the category tree by clicking the (+). Once 
the parent category expands, click the desired child category name 
to select it.
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18. Once the file uploads and the File Name disappears, click Finished.

The file name should display under Files.

19. Click Publish.

A success message will be displayed on the top of the screen in red letters.

Verifying the Document Uploaded Successfully
Use this procedure to verify the document successfully uploaded into MES.

Prerequisites
Before you verify the success of your upload, you must first complete all the steps 
in the Uploading Documents Into MES topic.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Categories sub-tab.

4. Click the category name under which you uploaded your response documents.

The name of the file and its description should appear. If not, go back and 
repeat the steps listed in the Uploading Documents Into MES topic.

Important: Do not click any other button until the file has fully 
uploaded, or the upload process will fail. Also, if the response 
document contains one or more inline images, then please repeat 
steps 14 through 17 for every image file (.gif or .jpeg) that needs to 
be included in the response document.

Note: To publish another document you must start by clicking 
Publish sub-tab again. Do not try to use (re-cycle) data entered for a 
previous file. 
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Create an Associated Query and Upload it
You need to associate a query with a response document only if the document has 
merge fields that need to be filled automatically based on some input parameters. 
Refer to the Create an Associated Query section to create an associated query and 
upload it.

Associate the Suggested Response Document and the Query
To be able to associate the suggested response document and the query to expand 
the merge fields in the document, you will need to have the following data:

Document ID

Query ID (which you should have obtained by performing the steps in the 
section above)

To obtain the document ID, currently you have to run the following SELECT 
statement in SQL*Plus:

SELECT ITEM_ID

FROM JTF_AMV_ITEMS_TL

WHERE ITEM_NAME = ’DOCUMENT_TITLE’;

(Where DOCUMENT_TITLE is the title of the suggested response document you 
uploaded in MES).

To associate the suggested response document with the query, currently you have to 
run the following INSERT statement in SQL*Plus:

INSERT INTO JTF_FM_QUERY_MES

VALUES (DOCUMENT_ID, QUERY_ID, SYSDATE, USER_ID, SYSDATE, 
USER_ID, NULL, NULL, NULL);

Where DOCUMENT_ID is the document ID of the suggested response document 
obtained by running the SELECT statement above.

QUERY_ID is the ID of the uploaded query (noted when the query was uploaded)

Note: After uploading the query, click on the query name, now 
displayed in the table under the Query tab. Make a note of the 
QUERY ID for the query you just uploaded. You will need this ID 
to associate the query with the response document.
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SYSDATE is a system variable provided by SQL*Plus that always has the value of 
the current system date. 

USER_ID is the user ID for the account you used to log in, e.g. 11001

NULL values are inserted in the final three columns since they are not related to our 
product

Using Email Processing Workflow
A rules engine (error processing) needs to be setup to process unstructured email 
through eMail Center. The backbone of rules engine is created by using Oracle 
Workflow, which is a part of Oracle Applications 11i. The name of the workflow for 
unstructured eMail Processing is “Email Preprocessing”. The rules engine must be 
configured onsite to cater to the various business rules and requirements of the 
client.

This topic group provides an overview of both unstructured and structured 
workflows, a high-level view of the steps involved in configuring operations for 
workflows, and detailed instructions for performing each of the configuration steps, 
including:

■ The Unstructured Email Processing Workflow

■ The Structured Email Processing Workflow

■ Creating a Workflow Process

Error Processing
Errors that occur during eMail Center processing cannot be directly returned to the 
agent, since the agent and/or caller generally does not know how to respond to the 
error (in fact, eMail Center may be a background engine with no human operator). 
You can use Oracle Workflow Builder to define the events you want to occur in case 
of an error. Use Oracle Workflow Builder to modify the default error process 
associated with the process or create your own custom error process.

The error process can include branches based on error codes, send notifications, and 
attempt to deal with the error using automated rules for resetting, retrying, or 
skipping the failed activity. Once you define your error process you can associate it 
with any activity.

Defining Workflows
To build or modify workflows, you use the Oracle Workflow Builder application. 
Oracle Workflow Builder lets you create, view, or modify a business process with 
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simple drag and drop operations. Using the Workflow Builder, you can create and 
modify all workflow objects, including activities, item types, and messages.

Although unstructured and structured email processing workflows are referred to 
separately, there is only one workflow with multiple paths, one of which being 
structured.

Email Processing Workflow

Terms to know
Activity - A unit of work performed during a business process.

Node - An instance of an activity in a process diagram as shown in the Process 
window.

Process - A set of activities that need to be performed to accomplish a business goal.

Workflow - A workflow is a processing path, consisting of a series of process nodes 
linked together to form paths that support a particular business rule or set of 
business rules.
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The Unstructured Email Processing Workflow
The “Email Preprocessing“ workflow contains some mandatory nodes, which must 
be setup to get messages processed and passed to the eMC server.

These mandatory nodes are:

Note: These seven mandatory nodes must ALL be present in the 
workflow or the workflow will fail.

Node Name Function

Check Authorization Checks whether the message coming for the user is a 
valid eMail Center user. If not, it discards the message.

Structured Mail? Checks whether the message is structured or 
unstructured. If the message is structured, it calls the 
structured workflow processing.

Structured Mail 
Processing

Calls the structured workflow to process the message as 
a structured workflow.

Check User Group Routes the message depending on the account for which 
it was sent. For example, if the message was sent to the 
"Support " account, then it branches to the path for 
Support.

Classification Theme 
Repository

Processes the classification and theme. Stores the query 
and response themes for each classifications.

Message Header 
Processing

Processes the message header.

Extended Header 
Processing

Processes the extended header.

Theme Classification 
Processing

Classifies the incoming message and extracts the themes.

KB Specific Search Searches the knowledge base to retrieve related response 
documents.

Entering Queue Places the message in a queue after Processing. eMC 
Server retrieves the message from this queue and 
processes it further.
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The “Email Preprocessing“ workflow also contains some nodes that are not 
mandatory, but are essential to enhance the functionality. 

These nodes are:

The Structured Email Processing Workflow
Structured inbound email occurs when a customer completes a well defined form 
whose template was on a web site or received in an email message sent to the 
customer.

eMail Center has only one workflow for all that it does. The workflow, however, is 
comprised of paths for unstructured and structured inbound email. Earlier in this 
document, the unstructured workflow was shown with one path repeated several 
times to accommodate each user group.

In contrast, structured workflow has 12 different paths shown here, plus one path 
for invalid messages. Those 12 paths are labeled:

■ New Customer

■ Tell Me More 

■ Bug Report

■ Service Request Status

Node Name Function

Extract Key Value Retrieves the service request number.

Order Status Communicates between Fulfillment and eMail Center. 
Returns the response documents containing the service 
request status.

Qualify For 
Autorespond

Checks whether a auto-response from eMail Center 
should be sent or not depending on the attribute value 
“Threshold score”. Depending on the value of the 
threshold score, if the top classification score for the 
message is achieved or exceeded, the Autoresponding 
node is triggered.

Autoresponding Autoresponds to a sender with a set of documents 
having a score greater than the value of “Document 
Threshold Attribute”.
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■ Call Me

■ Customer Service Request (How may we help you?)

■ Create Service Request (Got a problem?)

■ Order Status

■ Cancel Order

■ Cancel Back Order

■ Dispatch/Service Call Request

■ Update Customer

All 12 paths share two common end points, one for success and one for failure. The 
invalid message path goes only to the failure end point.

Service Request Status (example)
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Structured Email Processing

Node Name Function

Get Message from IM 
APIs

Extracts the message content from the email server

Is Structure Valid? Checks to see if the email is a structured email

Get Email Type Checks to see if the email is web or text based

Is Message data correct 
and complete

Checks to see all the required data is complete and 
correct

Notify Sender of Invalid 
Message

Sends email back to sender if the email contains invalid 
data

Parse Web Message Extracts the required data from the web based email
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Parse Text Message Extracts the required data from the text based email

Get Request Type Extracts the type of request sent by the sender

Auto Acknowledge 
Reply to Sender

Sends an acknowledgment of receipt of the email request 
to the sender

Create Customer Creates a new customer record in the database

Create Outbound 
Response

Sends the processed response back to the customer

Create Callback Creates a record in the database for a call back

Notify Application Indicates completion of the process

Verify Customer Checks to see if the customer is a valid customer

Is it a lead? Checks to see if the customer is a lead

Lead Capture Creates a new lead in the database

Process Bug Report Creates a new bug in the database

Get Status from SR Returns the service request status from the database

Send Service Request 
Status

Sends the service request status to the customer

Create Callback Task Creates a callback task in the database

Create Service Request Creates a new service request in the database

Get Status from Order 
Capture API

Gets the status of the order from the database

Order Capture Order 
Cancellation

Cancels a previously placed order

Cancel the Back Order Cancels a back ordered order

Process Dispatch Call 
Request

Creates a dispatch call

Update Customer 
Information

Updates the customer information in the database

Node Name Function
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Creating a Workflow Process
The following high-level steps comprise configuring workflow properties for using 
default workflow processes and/or creating the new workflow process or node:

1. Creating the Lookup Codes

2. Using a Node

3. Setting the User ID

4. Configuring the Global Attributes

For configuring the default unstructured workflow process, follow steps 1 and 4.

For configuring the default structured workflow process, follow steps 3 and 4.

For creating a new unstructured process, follow steps 1, 2, 3, and 4

For creating a new structured process, follow steps 2, 3, and 4

Creating the Lookup Codes
Lookup codes are used in the workflow to link the email accounts with their 
respective workflow paths or processes. eMail Center ships with a set of default 
Lookup Codes, such as Support. These lookup codes should match the email 
accounts created in the Email Server (Refer to Creating Email Server Accounts) and 
defined in the eMail Center (Refer to Defining Email Server Accounts). If the 
account name does not match the default lookup codes, follow the steps below to 
create a new lookup code.

Steps
1. Login to Oracle Workflow Builder.

2. Select process->Mail Preproc

3. Double-click the screen.

In the Workflow Builder, Mail Preproc gets loaded.

4. From the Navigator screen of Oracle Workflow Builder, click Lookup Type.

5. Select IM User Address.

A list of default lookup codes appears.

6. Right-click IM User Address.

7. Select New Lookup Code.
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The Lookup Code screen appears.

8. Enter the following data:

■ Internal Name - this is the email account name that was created in IM and 
defined in the eMail Center. For example, you can enter "Marketing" for the 
Marketing account.

■ Display Name - this is the descriptive name that appears in the lookup 
code. (The Oracle Workflow Builder recommends that the Internal Name 
and Display Name are different).

9. Click OK.

Using a Node
This topic provides a high-level overview of the steps necessary to use nodes when 
building a workflow.

Steps
1. Login to Oracle Workflow Builder.

2. Select process->Mail Preproc

3. Double-click the screen.

In the Workflow Builder, Mail Preproc gets loaded.

4. From the Workflow Builder navigator, select Function.

All available nodes appear.

5. Drag and drop the desired nodes into the Process diagram.

6. Select either TRUE or FALSE for boolean return types.

7. Repeat steps 5 and 6 until you have made all desired changes to the workflow.

8. From the Workflow Builder main menu, select Verify.

Workflow Builder checks the verification of the new workflow.

9. If the verification is successful, save the new workflow to the database.
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Setting the User ID
Structured email processing responses come from the Fulfillment server, so you 
must be set up as a valid user in Oracle Fulfillment before you can receive a correct 
response.

The user ID is set up as a look up in the FND_LOOKUPS table and it is seeded 
there. The value of the user ID is retrieved using the following query:

select meaning

from fnd_lookups

where lookup_type = ’IEM_USERID’

To determine whether the value returned by the query is a valid fulfillment user, 
check the returned value with the fulfillment server. If not, you must change the 
value.

Configuring the Global Attributes
Use this procedure to customize the global attributes for structured and 
unstructured workflows.

Steps
1. Log in to the Oracle Workflow Builder as Oracle Applications User.

The Show Item screen appears, displaying a list of items.

2. From the list of items in the Show Item screen, select Email Preprocessing for 
unstructured, or select Structured Inbound Email Process for structured.

3. Click OK.

The Workflow Builder loads the workflow.

4. Configure the global attributes.

■ Set the following global attributes for unstructured:

Attribute Name Value

Repository Name Pre-seeded with ’SMS,MES’.

If other repositories are required, they must be added 
here.
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■ Set the following global attributes for structured:

Application ID Application ID that loaded, and therefore owns, 
documents into Marketing applications.

Extended Headers Currently picking up five extended headers that come 
with a message. The headers are pre-seeded with the 
following values:

Extended Header 1: MESSAGE-ID

Extended Header 2: ORGANIZATION

Extended Header 3: MAILER

Extended Header 4: LANGUAGE

Extended Header 5: CONTENT-TYPE

These attributes are retrieved from the messages and 
passed to the eMC Server.

These values can be changed to meet user 
requirements.

Value For Key Pre-seeded with the phrase "service request number is". 
If this phrase appears in the message body, the 
customer is asking for a service request status.

If customers want to send something different, this 
value must be changed.

Service Request User ID Defines a valid fulfillment user ID.

Before setting this value, check with the fulfillment 
service group to locate a valid user ID.

Service Request Document ID Defines a valid fulfillment document ID.

Before setting this value, check with the fulfillment 
service group to locate a valid document ID.

Attribute Name Value

SR DOC ID The service request document uses this attribute 
as an ID for returning the service request status.

Attribute Name Value
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Troubleshooting
This topic group describes ways of troubleshooting various problems that arise 
while installing, starting, and running Oracle eMail center. This chapter discusses 
problems in the following areas:

■ Installation

■ Configuration

■ Starting

■ Logging on

■ Running

■ Desktop

■ Performance

Installation

IM_IMT_EXTN Error
If you experience an error during eMail Center workflow processing with this 
package (IM_IMT_EXTN), contact the Metalink for the necessary patch. 

iMT Processing Error
Ensure that your LD_LIBRARY_PATH  environment variable contains $ORACLE_
HOME/ctx/bin for the external procedure LISTNER calls.

CREATE SR DOC ID The create service request document uses this 
attribute for returning the service request creation 
details.

Attribute Name Value
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Configuration

Manual Step(s) in question? 
Refer to the Implementation section on Modifying Existing Inbound Email 
Templates. Generally means that you have not added the config line to the 
zone.properties of your web server and/or pointed your HTML forms to the correct 
web server.

eMail Center does not function in a multiple-instance scenario
Oracle eMail Center can integrate to multiple instances. Refer to the Post-installation 
Steps (Server Side) section in this guide. The default is single-instance.

Classifications can not be created.
The classification account has not been configured and/or is improperly 
configured.

Starting

Unable to launch desktop
Check your system profiles.

Are your agent folders created?

Logging On
There are a variety of reasons why you may not be able to log on. You can use the 
JInitiator console to look at the process trail of events to determine why you were 
not able to log on.

Some of the possible problems with logging on include:

Unable to log on to Self Service Applications
Make sure that the Forms server and the database are up and running. Enable 
Jinitiator console for monitoring and if the error states ?Out of Memory?, clear the 
contents of the jcache directory. This directory is typically located in 
C:\Program\Files\Oracle\JInitator\jcache
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Unable to log on to CRM e-Business Suite
Make sure that the Apache server is up and running. Set up user and password 
correctly. Make sure that the System Profiles have been set up correctly.

Passwords are case-sensitive and you used the wrong case.

You forgot your password or you used an incorrect password. There is no way to 
determine your old password but your administrator can assign a new password.

Your account may not be properly configured. Your administrator can make 
required changes to your account configuration.

You were logged on but the system logged you off.

eMail Center allows only one log on per user, someone else may have used your log 
on.

Running

eMails not being processed
Make sure that the Oracle Email Server is up and running, EMC Server is running, 
MCM Server is running, UWQ is running

Not getting automated email responses
Check if the Fulfillment server is up and running, Master Documents are loaded in 
Fulfillment

Documents not being retrieved
Load documents into MES

No structured response generally means that the Fulfillment server is not running.

Template merge is incomplete
Two types of merge fields (straight-insert & query) are supported in the eMail 
CenterTemplate/Suggested Response Merge functionality.   This error generally 
means that not all of the straight-insert data was available.

 eMail failed to reach AQ1
This generally means that the IM db link does not exist. Refer to Implementation 
section of this document.
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eMail fails to reach account inbox
This generally means that the email account (e.g. support@...) has not been 
configured to deliver emails to AQ1.

eMail goes to retry folder
This generally means that the concurrent manager is not running.

Unable to transfer message
This generally means that the other agent’s folder(s) do not exist.

Themes are not being created
Refer to the Creating Themes from the Operations Manager Console section of this 
guide.

Customer Support/Universal Work Queue Selector not displayed
This generally means that the Forms server is not running and/or you do not have 
proper privileges.

Unable to display UWQ desktop
This generally means that JTF has updated the package and didn't follow the safe 
package spec. guidelines, causing dependent Forms to get out of sync. with the 
package. Rebuild all of the existing IEU Forms components (PLSs/PLLs and 
FMBs/FMXs) and this problem will go away.

Failed to launch HTML application
Generally means that the incorrect component is being specified.

Markup text does not work
Oracle interMediaText currently works only in English.

Markup text does not find relevant information
Tweak the linguistic processing module by customizing the theme. For additional 
information refer to Oracle interMediaText (iMT) documentation.

New eMail classification failed
Use sample messages for your classifications that completely represent the subject 
matter anticipated in emails belonging to the classification.
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The auto response failed
Check your threshold settings for confidence scores on incoming message 
classification.

All classifications were not displayed
The system maximum is seven (7).

Desktop

Unable to compose/create message
Classifications are not being displayed.

The desktop failed to find your theme related documents. Verify that your 
documents are contained within the Marketing Encyclopedia systems repository. 
View your documents from the desktop MES tab.

Performance

The maximum system browser cache is inadequate for your memory
 Clear your cache.

The desktop is partially displayed and/or you must scroll to view the 
entire desktop
Increase your display resolution to 1200 by 1000 and maximize displayed window.

Access speed depends largely on your network architecture and somewhat on your 
PC processor and memory.

New and/or modified workflow processes do not function and/or poorly 
perform and seem to hang
Verify your logic and query design. Isolate and analyze the suspected query. Create 
test cases.

Abbreviations
API - Application Programming Interface

CRM - Customer Relationship Management
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eMC - Email Center

HTML - Hyper Text Markup Language

IEM - Product code for eMail Center

IH - Interaction History

IMAP - Internet Messaging Access Protocol

JMA - Java Mail API

JSP - Java Server Pages

JTF - CRM Foundation Layer

KB - Knowledge Base

KMS - Knowledge Management Systems

MCM - Multi Channel Manger

MES - Marketing Encyclopedia System

NLS - National Language Support

OES/IM - Oracle Email Server/Internet Messaging

OTM - Oracle Telephony Manager

SMS - Solution Management System

SMTP - Simple Mail Transport Protocol

URL - Universal Resource Locator

UWQ - Universal Work Queue

WWW - World Wide Web

Glossary
Apache - A third party web server

Applet - A Java program that runs in the Internet browser

Browser - Application that helps in accessing the Internet (Internet Explorer and 
Netscape)

Classification (email) - The main subject of the email

Client Desktop - The eMail Center email browser
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Customer Care - Oracle Product

Distribute - Means that it puts the email into the queue of the agent or agent group 
that the router identified

Domain - Refers to the domain name in which the email resides

eMail Center - Oracle Product

Fulfillment - Oracle Product

Hostname - Refers to the name of the machine on which the SMTP server is 
running

interMedia Text - Oracle Product

iSupport - Oracle Product

Java - Programming Language

Knowledge Base - A repository of documents that can be queried

Multiple Instances - CRM and IM are installed in different databases

Response Template - The template that will be used to reply to customers

Single Instance - CRM and IM share the same database

Structured email - An email whose content and structure are known

Unstructured email - An free form email

Web Template - A web page that accepts user input and creates a structured email

Work Queue - A logical queue that holds each Agent’s emails

 Administering Oracle eMail Center Through
the Admin Console

The Admin console allows you to:

- enable and disable advanced queues

-create, modify, or delete:

■ accounts

■ server groups
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■ EMC servers

■ database servers

■ database links

■ email servers

This topic group covers the following topics:

Creating Agent Accounts

Viewing Account Information

Editing Account Information

Creating Server Groups

Modifying Server Groups

Deleting Server Groups

Creating EMC Servers

Modifying EMC Servers

Deleting EMC Servers

Creating Database Servers

Modifying Database Servers

Deleting Database Servers

Creating Database Links

Deleting Database Links

Creating E-Mail Servers

Modifying E-Mail Servers

Deleting E-Mail Servers

Enabling and Disabling Advanced Queues

Creating Accounts
Use this procedure to create accounts.
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Prerequisites
You must have an administrator level login ID to be able to create accounts.

Steps
1. From the eMail Center Admin screen, click the Account tab.

The Accounts screen appears, displaying information in table form on all 
current accounts.

2. Click Create. 

The Create Account screen appears.

3. Type the account information in the provided fields.

4. Once you have provided the required information, click Create.

You are returned to the Accounts screen and your new account is displayed in 
the table.

References
Viewing Account Information

Editing Account Information

Viewing Account Information
Use this procedure to view account information.

Prerequisites
You must have a valid login ID to view account information.

Steps
1. From the eMail Center Admin screen, click the Account tab. 

The Accounts screen appears.

2. From the account information table on the Accounts screen, locate the account 
you wish to view.

3. From the Name column, double-click the desired account name.

The Account Details screen appears and the detailed information for the 
selected account is displayed.
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 References
Creating Agent Accounts

Editing Account Information

Editing Account Information
Use this procedure to edit account information.

Prerequisites
You must have an administrator level login ID to be able to create accounts.

Steps
1. From the eMail Center Admin screen, click the Account tab. 

The Accounts screen appears.

2. From the account information table on the Accounts screen, locate the account 
you wish to view.

3. From the Name column, double-click the desired account name.

The Account Details screen appears and the detailed information for the 
selected account is displayed.

4. Change the desired account information and click Update. 

The account information updates and you return to the Accounts screen.

Note: All fields with an asterix (*) next to the field name are 
required and must have information entered into them.

Note: If you do not see your new account displayed, use the First, 
Previous, Next and Last commands to locate it in the information 
table. If the information table is large, use the quick find search 
feature.
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References
Creating Agent Accounts

Viewing Account Information

Creating Server Groups
Use this procedure to create a server group.

Prerequisites
You must have an administrator level login ID to be able to create server groups.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click Group.

The Server Groups screen appears.

3. From the Server Groups screen, click Create.

The Create Group screen appears.

4. Type a group name and a group description in the provided fields.

5. Click Create.

The server group is created and you return to the Server Groups screen.

References
Deleting Server Groups

Creating EMC Servers

Creating Database Servers

Note: You can delete changes by clicking Restore; however once 
changes are committed to the database, clicking Restore will no 
longer correct them.

Note: If you do not see your new server group displayed, use the 
Next and Last commands to locate it in the list.
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Creating Database Links

Creating E-Mail Servers

Enabling and Disabling Advanced Queues

Modifying Server Groups
Use this procedure to modify server groups.

Prerequisites
None.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click Group.

The Server Groups screen appears.

3. From the Group Name column, double-click the desired server group name.

The Server Group Details screen appears.

4. Modify the group name or group description as desired.

5. Click Update.

The selected server group updates and you return to the Server Groups screen.

Deleting Server Groups
Use this procedure to delete server groups.

Prerequisites
You must have an administrator level login ID to be able to delete server groups.

Steps
1. From the eMail Center Admin screen, click the Server tab.

Note: You can delete changes by clicking Restore; however once 
changes are committed to the database, clicking Restore will no 
longer correct them.
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2. Click Group.

The Server Groups screen appears.

3. From the Remove column, click the checkbox for the server group you wish to 
remove.

4. Click Update.

The selected server group is removed.

References
Creating Server Groups

Deleting EMC Servers

Deleting Database Servers

Deleting Database Links

Deleting E-Mail Servers

Enabling and Disabling Advanced Queues

Creating EMC Servers
Use this procedure to create an EMC server.

Prerequisites
You must have an administrator level login ID to be able to create EMC servers.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click EMC.

The EMC Servers screen appears.

3. From the EMC Servers screen, click Create.

The Create EMC Servers screen appears.

4. Type the EMC server name, DNS name, and IP address in the provided fields.

5. Select the group server from the drop down list in the Group Server field.

6. Click Create.
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The EMC server is created and you return to the EMC Servers screen.

References
Creating Server Groups

Creating Database Servers

Creating Database Links

Creating E-Mail Servers

Enabling and Disabling Advanced Queues

Modifying EMC Servers
Use this procedure to modify EMC servers.

Prerequisites
You must have administrator level login to modify EMC servers.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click EMC.

The EMC Servers screen appears.

3. From the EMC Server Name column, double-click the desired EMC server 
name.

The EMC Server Details screen appears.

4. Modify the EMC server name, DNS name, IP address, and group server as 
desired.

5. Click Update.

The EMC Server is updated and you return to the EMC Servers screen.

Note: If you do not see your new EMC server displayed, use the 
Next and Last commands to locate it in the list.
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Deleting EMC Servers
Use this procedure to delete EMC servers.

Prerequisites
You must have an administrator level login ID to be able to delete EMC servers.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click EMC.

The EMC Servers screen appears.

3. From the Remove column, click the checkbox for the EMC server you wish to 
remove.

4. Click Update.

The selected EMC server is removed.

References
Deleting Server Groups

Creating EMC Servers

Deleting Database Servers

Deleting Database Links

Deleting E-Mail Servers

Enabling and Disabling Advanced Queues

Creating Database Servers
Use this procedure to create a database server.

Note: You can delete changes by clicking Restore; however once 
changes are committed to the database, clicking Restore will no 
longer correct them.



Modifying Database Servers

142   Oracle eMail Center Concepts and Procedures

Prerequisites
You must have an administrator level login ID to be able to create database servers.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click Email DB.

The Database Servers screen appears.

3. From the Database Servers screen, click Create.

The Create Database screen appears.

4. Type the database name, hostname, port, protocol, SID, service name, 
description, and RT availability in the provided fields.

5. From the drop down list in the Group Server field, select the group server.

6. Click Create.

The database server is created and you return to the Database Servers screen.

References
Creating Server Groups

Creating EMC Servers

Deleting Database Servers

Creating Database Links

Creating E-Mail Servers

Enabling and Disabling Advanced Queues

Modifying Database Servers
Use this procedure to modify database servers.

Prerequisites
You must have an administrator level login to modify database servers.

Note: If you do not see your new database server displayed, use the 
Next and Last commands to locate it in the list.



Deleting Database Servers

Administering Oracle eMail Center Through the Admin Console 143

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click Email DB.

The Database Servers screen appears.

3. From the Database Servers screen, double-click the desired database server 
name.

The Database Server Details screen appears.

4. Modify the database name, hostname, port, protocol, database SID, service 
name, database description, RT availability and group server as necessary.

5. From the Database Server Details screen, click Update.

The database server is updates and you return to the Database Servers screen.

Deleting Database Servers
Use this procedure to delete database servers.

Prerequisites
You must have an administrator level login ID to be able to delete database servers.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click Email DB.

The Database Servers screen appears.

3. From the Remove column, click the checkbox for the database server you wish 
to remove.

4. Click Update.

The selected database server is removed.

Note: You can delete changes by clicking Restore; however once 
changes are committed to the database, clicking Restore will no 
longer correct them.
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References
Deleting Server Groups

Deleting EMC Servers

Creating Database Servers

Deleting Database Links

Deleting E-Mail Servers

Enabling and Disabling Advanced Queues

Creating Database Links
Use this procedure to create database links.

Prerequisites
You must have an administrator level login ID to be able to create database links.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click DB Link.

The Database Links screen appears.

3. From the Database Links screen, click Create.

The Create Database Link screen appears.

4. Select the server from the drop down list in the Server field.

5. Type the server, name, user and password in the provided fields.

6. Click Create.

The database link is created and you return to the Database Links screen.

References
Creating Server Groups

Note: If you do not see your new DB LinkName displayed, use the 
Next and Last commands to locate it in the list.
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Creating EMC Servers

Creating Database Servers

Deleting Database Links

Creating E-Mail Servers

Enabling and Disabling Advanced Queues

Deleting Database Links
Use this procedure to delete database links.

Prerequisites
You must have an administrator level login ID to be able to delete database links.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click DB Link.

The Database Links screen appears.

3. Click the checkbox adjacent to the database link you wish to remove.

4. Click Drop.

The selected database link is removed.

References
Deleting Server Groups

Deleting EMC Servers

Deleting Database Servers

Creating Database Links

Deleting E-Mail Servers

Enabling and Disabling Advanced Queues

Creating Email Servers
Use this procedure to create email servers.
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Prerequisites
You must have an administrator level login ID to be able to create email servers.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click Email.

The E-mail Servers screen appears.

3. From the E-mail Servers screen, click Create.

The Create E-mail Server screen appears.

4. Type the email server name, DNS name, IP address, port, and RT availability in 
the provided fields.

5. Select the group server from the drop down list in the Group Server field.

6. Select the email server type from the drop down list in the E-Mail Server Type 
field.

7. Click Create.

The email server is created and you return to the E-mail Servers screen.

References
Creating Server Groups

Creating EMC Servers

Creating Database Servers

Creating Database Links

Creating E-Mail Servers

Deleting E-Mail Servers

Enabling and Disabling Advanced Queues

Note: If you do not see your new email server name displayed, use 
the Next and Last commands to locate it in the list.
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Modifying Email Servers
Use this procedure to modify email servers.

Prerequisites
You must have an administrator level login to modify email servers.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click Email.

The E-mail Servers screen appears.

3. From the Server Name column, double-click the server name for the E-Mail 
Server you wish to modify.

The E-Mail Server Details screen appears.

4. Update the E-Mail server name, DNS address, IP address, port, RT availity, 
group server and E-Mail server type as desired.

5. Click Update.

The E-Mail Server is updated and you return to the E-Mail Servers screen.

Deleting Email Servers
Use this procedure to delete email servers.

Prerequisites
You must have an administrator level login ID to be able to delete email servers.

Steps
1. From the eMail Center Admin screen, click the Server tab.

2. Click Email.

The E-mail Servers screen appears.

Note: You can delete changes by clicking Restore; however once 
changes are committed to the database, clicking Restore will no 
longer correct them.
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3. From the Remove column, click the checkbox for the server group you wish to 
remove.

4. Click Update.

The selected email server is removed.

References
Deleting Server Groups

Deleting EMC Servers

Deleting Database Servers

Deleting Database Links

Creating E-Mail Servers

Enabling and Disabling Advanced Queues

Enabling and Disabling Advanced Queues
Use this procedure to enable or disable advanced queues.

Prerequisites
You must have an administrator level login ID to be able to enable and disable 
advanced queues.

Steps
1. From the eMail Center Admin screen, click the Queue tab.

The Advanced Queues screen appears.

2. From the Select column, click the check box for the desired queue.

3. To enable the queue, click Enable.

4. To disable the queue, click Disable.

5. Once you have enabled or disabled the desired queues, click Refresh.

The Advanced Queues screen updates to reflect the new queue status.

References
Creating Server Groups
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Creating EMC Servers

Creating Database Servers

Creating Database Links

Creating E-Mail Servers

Administering Oracle eMail Center Through
the Operations Manager Console

The Operations Manager console allows you to:

-create, modify, or delete:

■ classifications

■ queries

■ datasource files

■ templates

■ master documents

■ collateral

This topic group covers the following topics:

Creating Classifications

Modifying Classifications

Deleting Classifications

Creating Queries

Modifying Queries

Creating Datasource Files

Creating Templates

Viewing Templates

Modifying Templates

Inactivating Templates
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Creating Master Documents

Uploading Master Documents

Creating Classifications
Use this procedure to create classifications.

Prerequisites
You must have an administrator or operations manager level login to create 
classifications.

Steps
1. From the Oracle Applications Operations Manager screen, click the 

Classification tab.

The Classification screen appears.

2. From the Classifications screen, click Create.

The Create Classification screen appears.

3. Type the classification name in the Classification Name field.

4. Select the email account from the drop down list in the Email Account field.

5. Click Create.

The classification is created and you return to the Classification screen.

Modifying Classifications
Use this procedure to modify classifications.

Prerequisites
You must have an administrator or operations manager level login to modify 
classifications.

Steps
1. From the Oracle Applications Operations Manager screen, click the 

Classification tab.

The Classification screen appears.
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2. From the Classification screen, click Update.

The Update Classification screen appears.

3. Change the classification name and email account as desired.

4. Click Update.

The classification is updated and you return to the Classification screen.

Deleting Classifications
Use this procedure to delete classifications.

Prerequisites
You must have an administrator or operations manager level login to delete 
classifications.

Steps
1. From the Oracle Applications Operations Manager screen, click the 

Classification tab.

The Classification screen appears.

2. From the Remove column, click the checkbox for the classification you wish to 
remove.

3. Click Clear.

The selected classification is deleted.

Creating Queries
Use this procedure to create queries.

Prerequisites
You must have an administrator or operations manager level login to create queries.

Steps
1. From the Oracle Applications Operations Manager screen, click the Query tab.

The Queries screen appears.

2. From the Queries screen, click Create.
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The Create Queries screen appears.

3. Type the query name, query description, query string, application database 
name, application user name, and application password in the provided fields.

4. Click Update.

The query is created and you return to the Queries screen.

Modifying Queries
Use this procedure to modify queries.

Prerequisites
You must have an administrator or operations manager level login to modify 
queries.

Steps
1. From the Oracle Applications Operations Manager screen, click the Query tab.

The Queries screen appears.

2. From the Queries screen, click Update.

The Update Query screen appears.

3. Change the query name, query description, query string, application database, 
application user name, or application password as desired.

4. Click Update.

The query is updated and you return to the Queries screen.

Note: If you do not see your new query displayed, use the First, 
Previous Set, Next Set and Last commands to locate it in the 
information table. If the information table is large, use the quick 
find search feature.



Creating Templates

Administering Oracle eMail Center Through the Operations Manager Console 153

Creating Datasource Files
Use this procedure to create datasource files.

Prerequisites
Before you create the datasource file, you must first create the query to which you 
want to attach the file.

Steps
1. From the Oracle Applications Operations Manager screen, click the Query tab.

The Queries screen appears.

2. From the Queries screen, click Datasource located directly under the Template 
tab.

The Create Datasource file for query screen appears.

3. Select the desired query name from the drop down list in the Query Name field.

4. Click Create.

The datasource file is created and you return to the Queries screen.

Creating Templates
Use this procedure to create templates.

Prerequisites
You must have an administrator or operations manager level login to create 
templates.

Steps
1. From the Oracle Applications Operations Manager screen, click the Template 

tab.

Note: If you do not see your updated query displayed, use the 
First, Previous Set, Next Set and Last commands to locate it in the 
information table. If the information table is large, use the quick 
find search feature.
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The Templates screen appears.

2. From the Templates screen, click Create.

The Create Templates screen appears.

3. Type the template name, template description, and campaign in the provided 
fields.

4. Select the status from the drop down list in the Status field.

5. Click Create.

The template is created and you return to the Templates field.

Viewing Templates
Use this procedure to view templates.

Prerequisites
None.

Steps
1. From the Oracle Applications Operations Manager screen, click the Template 

tab.

The Templates screen appears.

2. From the Template Name column, double-click the desired template name.

The View Template screen appears, displaying the selected template.

Note: If you do not see your new template displayed, use the First, 
Previous Set, Next Set and Last commands to locate it in the 
information table. If the information table is large, use the quick 
find search feature.

Note: If you do not see the desired template name listed in the 
Template Name column, you can select the desired template from 
the drop down list in the View field.
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Modifying Templates
Use this procedure to modify templates.

Prerequisites
You must have an administrator or operations manager level login to modify 
templates.

Steps
1. From the Oracle Applications Operations Manager screen, click the Template 

tab.

The Templates screen appears.

2. From the Template Name column, double-click the desired template name.

The View Template screen appears, displaying the selected template.

3. Modify the template name, status, template description and campaign as 
desired.

4. Click Update.

The template is modified and you return to the Templates screen.

Inactivating Templates
eMail Center does not allow you to delete templates; however, you can make 
templates inactive, thereby preventing them from appearing inside the client 
portion when responding to incoming email.

Note: If you do not see the desired template name listed in the 
Template Name column, you can select the desired template from 
the drop down list in the View field.

Note: If you do not see your updated template displayed, use the 
First, Previous Set, Next Set and Last commands to locate it in the 
information table. If the information table is large, use the quick 
find search feature.
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Prerequisites
You must have an administrator or operations manager level login to inactivate 
templates.

Steps
1. From the Oracle Applications Operations Manager screen, click the Template 

tab.

The Templates screen appears.

2. From the Template Name column, locate the desired template name.

3. In the status column, select inactive from the drop down list in the status field 
for the template you wish to inactivate.

4. Click Update.

The template’s status changes to inactive.

Creating Master Documents
Master documents are not created in the Operations Manager GUI. Instead, they are 
created externally with a text authoring tool such as Microsoft Word, then uploaded 
to the Operations Manager GUI.

Prerequisites
You must have access to a text authoring tool to be able to create master documents. 
You mush have sufficient space on a hard drive (local or network) to store the 
master document once you’ve created it.

Steps
1. Open your text authoring tool and type the desired text for the master 

document.

2. Save the text file to a hard drive (local or network).

Note: If you do not see the desired template name displayed, use 
the First, Previous Set, Next Set and Last commands to locate it in 
the information table. If the information table is large, use the quick 
find search feature.
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Uploading Master Documents
Use this procedure to upload master documents.

Prerequisites
You must have access to a text authoring tool to be able to upload master 
documents.

Steps
1. From the Oracle Applications Operations Manager screen, click the Template 

tab.

The Templates screen appears.

2. From the Templates screen, click Master Document (located directly under the 
tabs).

The Master Documents screen appears.

3. From the Master Documents screen, click Upload.

A browse window appears, allowing you to navigate to the drive, directory, and 
folder where you saved the file.

4. Select the desired file from the designated folder.

5. Click OK.

The selected master document is uploaded and you return to the Master 
Document screen.

Note: eMail Center accepts .txt, .doc, .pdf, .htm, and .zip file 
extensions.
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